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A Tool for the Generation and Analysis of Model
Simulation Scenarios for Watersheds (GenScn)

By John L. Kittle, Jr., Aqua Terra Consultants,
Alan M. Lumb, U.S. Geological Survey,
Paul R. Hummel, Paul B. Duda and Mark H. Gray,
Aqua Terra Consultants

Abstract
Analyzing and managing the high volumes of input and output of complex river basin models is a major
task.  These models are used to simulate water quantity and quality for numerous scenarios of changes in
land use, land-use management practices, and water-management operations.  To assist with that process,
an interactive computer program, GENeration and analysis of model simulation SCeNarios (GenScn),
was developed to create simulation scenarios, analyze results of the scenarios, and compare scenarios.
Although other models can be adapted to use GenScn, this report describes the system as adapted for the
Hydrological Simulation Program-Fortran (HSPF).  HPSF is a highly versatile model capable of
simulating mixed-land-use watersheds (urban and rural).  It includes land surface and instream water
quantity and quality components.
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Introduction

Purpose of Report

This manual assists both end users and system administrators with the installation and application of the
interactive computer program GENeration and analysis of model simulation SCeNarios (GenScn).
GenScn was developed to create simulation scenarios, analyze results of the scenarios, and compare
scenarios. Although other models can be adapted to use GenScn, this report describes the system as
adapted for the Hydrological Simulation Program-Fortran (HSPF).  HPSF is a highly versatile model
capable of simulating mixed-land-use watersheds (urban and rural).  It includes land surface and instream
water quantity and quality components.

Following this introduction is a section entitled User’s Guide for river basins that already have the
necessary files for GenScn. The last section,  Setting Up a New Scenario Generator, documents the
details necessary for a scenario generator administrator to create data sets for GenScn for a new river
basin. The appendixes include supplemental information on the GenScn software and utility programs to
help create the needed data sets. This report is also available as hyperlinked graphical files accessible
from the GenScn system, which can be used by   readers with access to the required software and
hardware (see the System Requirements and Obtaining GenScn sections for details).

Background

Use of the Hydrological Simulation Program-Fortran (HSPF) watershed model (Bicknell and others,
1997) traditionally involved using a text editor to build an input sequence to describe a watershed’s
physical and water management characteristics. For large, complex river basins, input sequences were
often thousands of lines long when water quality was simulated in addition to the hydrology. The process
of making changes was time consuming and complex. In addition, analyzing results from several HSPF
runs required manually and tediously keeping track of time-series data sets from all scenarios at multiple
locations for several constituents. The analyzer often had to reformat the results and use separate
programs to analyze results and prepare the needed tables and graphs.

The development of a scenario generator came as a response to the need to make HSPF input sequences
easier to build and HSPF input/output time series easier to analyze. The scenario generator provides
advanced interaction with the HSPF input sequence and integrated analysis capabilities. The program
provides an interactive framework for analysis built around an established and adaptable watershed
model. The U.S. Geological Survey Illinois District in cooperation with Dupage County Illinois provided
funding for the incorporation of the Full Equations Model (FEQ) into GenScn.
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Capabilities and Uses

GenScn provides the ability to change an input sequence interactively, run the HSPF model, and view
results graphically. The results of different scenarios can be easily compared and analyzed because the
model and analysis tools are linked in one package and use a common data base.

A scenario consists of an input sequence, its output reports, and associated time-series data. Each input
sequence describes a scenario. Once the model is run for a particular scenario, output reports and time-
series data specified in that scenario’s input sequence are available for analysis. A new scenario is
created by copying an existing input sequence, modifying this input sequence to describe the new
scenario, and then running the model. Where specified by the input sequence, output files and time-series
data are automatically generated when the new scenario is run for comparison with other scenarios.

When changes to the input are complete, the HSPF model can be executed. HSPF checks the validity of
the input sequence. Changes that are incomplete or inconsistent are referred back to the user for further
refinement.

After execution is complete, the user may interactively specify results to be analyzed. Data to analyze
may be specified by selecting scenario, location, and constituent names. Locations may also be specified
graphically by clicking locations on a map. Results can be viewed either on the display screen or on
printed output.

Results are available as tables and plots of simulated or observed data or statistical analyses of the data.
A wide range of plots can be specified, including a standard time-series plot, a residual time-series plot
against another time series, a cumulative differences time-series plot, a bar chart, a flow-duration plot, a
scatter plot of one time series against the difference between two other time series, a scatter plot of two
time series including an optional 45-degree line and regression line, and an event-frequency plot. Three
special types of statistical analyses are: comparing two time series over a range of class intervals,
constituent duration analysis, and frequency analysis.

For specifics on how to perform the functions described here, see the Tutorial section of this document.
The Tutorial section contains a set of lessons with specific examples illustrating the use of GenScn in
various project situations.
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User’s Guide

Introduction

This user’s guide provides:

• a description of how to use the forms and menus of the user interface;

• an overview of the system architecture, special files, and sample data;

• a tutorial containing a set of lessons that shows the major features of GenScn; and

• a detailed description of the forms and menus along with the output tables and graphs for each major
function in GenScn (detailed functions).

User Interface

The majority of the user interface consists of standard Windows 95/NT components.  All forms within
the system are made up of varying numbers of menus, toolbars, buttons, lists, check boxes, radio buttons,
and text boxes.  All mouse interaction is through the left mouse button.  More detailed information on the
objects, which make up the forms, may be found in the Windows 95/NT on-line help.

A few extensions to the Windows 95/NT interface are also included in GenScn.  These are controls for
manipulating dates, editing tables (grids) of data, and editing text fields with limits and help information
tied to the field.  Although these controls are extensions, they operate in a similar manner to Windows
95/NT.

Graphical User Interface Conventions

GenScn was developed for user interaction to take place through a graphical user interface (GUI).
Screens are organized in a logical manner to minimize both user learning time and user mouse/keystroke
effort.  Information within GenScn is often organized in layers, with the most basic and important
information being readily available and more detailed and less frequently used information being
accessed through additional menus or buttons.  Another way that information may be layered is through
the use of overlaid tabs, with the most frequently used tabs on top of the stack.

GenScn was also designed to assist the user in keeping track of where they are in the system.  This was
done by labeling all of the sub forms with titles that indicate the task being performed.  This labeling also
confirms to the user that they got to the right place in the system after selecting a menu option or button.
The label on the main form is updated to include the name of the project being run every time a project is
opened.
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Keyboard Shortcuts

To allow users the flexibility of not using a mouse, keyboard shortcuts have been provided to perform all
of the functions throughout GenScn.  Some controls, such as menus and buttons, may be activated by
holding down the Alt key and then pressing the letter underlined in the control.  Other controls may only
be manipulated using keyboard shortcuts if the control has the “focus.”  Focus means that the control can
receive keyboard or mouse input.  Focus is indicated by a dashed line surrounding the control.  When
using the keyboard, the focus is changed from one control to the next by using the Tab key (a mouse sets
the focus to the control on which it has clicked).

Menu titles may be activated by holding down the Alt key and then pressing the letter underlined in the
desired menu title.  Once a menu title has been activated (that is, pulled down), the desired menu item
may be selected by pressing the underlined letter or by highlighting the item using the arrow keys and
then pressing the Enter key.  For example, to select the File:Open menu item, one would type ALT-FO.

Buttons may be activated in one of two ways.  If a button caption has an underlined letter, holding down
the Alt key and pressing the underlined letter will activate the button.  A button may also be activated by
setting the focus to the button and then pressing the Enter key.

In this picture, the Ok button has a keyboard shortcut, indicated by the underline, so pressing Alt-O will
activate the Ok button as if it had been clicked with the mouse. The dashed line around the Cancel button
indicates that button currently has focus, so pressing Enter will activate the Cancel button as if it had
been clicked with the mouse. A button labeled ‘Cancel’ can also be activated by pressing the Esc key.

Selection of list items is performed in different ways depending on the type of list. A scrollable list
allows multiple items to be selected.  To select items in a scrollable list, set the focus to the list, use the
arrows to set the focus to the desired item, and then press the space bar to highlight the item.  A drop-
down list allows only one item from a list to be selected.  To select the desired item from a drop-down
list, set the focus to the list and use the arrow keys to highlight the desired item.

Selection of option buttons and check boxes may be made in two ways.  If an option button or check box
caption has an underlined letter, holding down the Alt key and pressing the underlined letter will select
the item.  Option buttons and check boxes may also be selected by setting the focus to them and using the
arrow keys to highlight the desired item.  For option buttons, this will automatically select the button.
For check boxes, the space bar must be pressed to select the highlighted item.

If a form contains layered tabs of information, a tab may be moved to the front by holding down the Alt
key and pressing the underlined letter in the caption of the desired tab.
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Toolbars

Toolbars are used in GenScn to provide quick access to the most frequently used functions.  When
applicable, the toolbars are located in close proximity to the control(s) with which their functions are
associated.  This allows a single click of a nearby button to perform a function, rather than moving to the
top of the form to pull down a menu title and select a menu item.  The toolbar buttons contain graphical
images to assist the user in recalling what each button does.  Additionally, toolbar buttons contain
tooltips, which provide a text description of each button when the mouse pointer is held over the button
for a brief moment. Toolbars are provided on the main form of GenScn to work with the map, the time-
series buffer, and the analysis options.
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Common Dialogs

Some interactions that are routinely performed in the Windows 95/NT interface are handled using
common dialogs. These are forms that have consistent interfaces for routine tasks. The user will then be
familiar with the form each time one of these tasks are performed. Within GenScn, the tasks performed
using common dialogs are retrieving or saving a file and selecting a printer and specifying its properties.

File Dialog

In GenScn, the user is frequently prompted for file names when saving or retrieving a file. The list at the
top of the form (labeled either ‘Save in’ or ‘Look in’) displays the current directory path. Use of the pull-
down arrow on this list allows the user to move to any directory above the current one. Directories below
the current one are displayed in the large middle box. The desired directory is selected by double clicking
on it. The buttons to the right of the top list are used for (from left to right) moving up one directory
level, creating a new directory (or folder), and specifying whether to display a standard or detailed list of
the directories and files contained in the current directory. The middle box also displays any existing files
of the file type specified. The file type specification is made in the list at the bottom of the form (labeled
either ‘Save as type’ or ‘Files of type’). The ‘File name’ text box is used to enter the name of the file.
Clicking on a file listed in the middle box will put the name of the file in the ‘File name’ box. A file is
selected either by double clicking a file name in the middle box or by filling in the ‘File name’ box and
clicking the ‘Save’ button or the ‘Open’ button. Selecting an existing file during a save will cause a
prompt to be displayed confirming that it is all right to overwrite the file.
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Print Dialog

Another function in GenScn handled by a common dialog is that of specifying the printer to use when
printing.  The ‘Printer’ list at the top of the form is used to select the desired printer from those available.
The lines below the list give information about the selected printer.  The ‘Properties’ button to the right
of the printer list gives access to more detailed specifications about the selected printer (that is, page
orientation, paper size, and so forth).  Checking the ‘Print to file’ check box will result in the user being
prompted for a file name to which to print when the ‘OK’ button is selected.  Additional specifications
may be made related to which pages to print (when applicable) and the number of copies.
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Help System

There are various levels of Help within GenScn and they may be accessed in different ways. The Help
menu title on the main GenScn form has two menu items: About and Contents.  The About item is used
to display a summary of the version of GenScn being run.  The Contents item is used to bring up a
window that allows the user to move throughout the entire GenScn help file.  The user may move through
the help file by using the hierarchical structure or the index of help topics.

Context-sensitive access to the GenScn help file is provided through the F1 key. Pressing the F1 key from
any form will display the relevant topic in the help file.

An additional level of help that pertains to the model being run in GenScn is also available.  This help is
available in the Scenario Activate form when the user is editing the model’s input sequence. Help will be
displayed that pertains to the model parameter being edited.

System Overview

This section includes information relating to the  system hardware and software requirements,
downloading the program and documentation, architecture,  special required files, and sample data.

System Requirements

GenScn requires a computer running Windows 95 or Windows NT Version 4.0 or higher. The minimum
platform configuration is a 486 or equivalent processor running at 50 megahertz with 16 megabytes of
memory, at least 60 megabytes of free disk space, and display resolution of at least 1024 x 768. For
optimal performance, a Pentium processor running at 200 megahertz or faster with at least 64 megabytes
of memory, 100 megabytes of free disk space, and display resolution of 1280x1024 recommended. A
color printer is also recommended.

Obtaining GenScn

GenScn may be obtained through the internet by accessing the U.S. Geological Survey Water Resources
Applications Software page (at: http://water.usgs.gov/software/). From this page follow the instructions
for downloading the software and installing it on your machine. The ftp site is water.usgs.gov in the
pub/software/surface_water directory.
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Architecture

A successful user interface for watershed modeling displays information to the watershed modeler in a
manner consistent with the modeler’s world view and needs. The goal of the interface is to provide layers
of information -- a summary of information about the project in the main form along with other forms
that show additional information. This includes details about the watershed, model parameters, and
results along with complete documentation of the model’s algorithms.

The GenScn user interface has a main form that uses a map to show the watershed’s spatial
characteristics, text boxes that summarize locations where detailed information is available, scenarios
that have been simulated (for model runs) or collected (for observed data), and constituents for which
data are available. From the main form the user can activate a scenario, edit the description and
parameters for the scenario, and run the model. The user may analyze results by selecting desired
scenarios, locations, and constituents and then selecting the time-series data available. A span of time and
the analysis tool(s) are then selected to generate the desired tables, graphs, statistical summaries, or
animations.

The design of reusable components has played a key role in the development of GenScn. The result of
using these components includes (1) reusability within GenScn (references from different locations or
with different parameter sets), (2) reusability within other modeling systems, and (3) more easily defined
and tested modules. Reusable components in GenScn include the date setting control, the range-checking
numeric entry box, the editable spreadsheet-style grid, the file viewing form, the map, and the graphs. A
significant effort has been invested in developing a suite of modules for the graphical and tabular display
of time-series data and other analysis results. The modules allow the programmer to set initial values for
the parameters that define the plot or listing (for example, data values, number of curves/columns, text
labels). All plots and listings can be customized by the end user.

Initially, GenScn used the Watershed Data Management (WDM) FORTRAN library of subroutines for
time-series management. A set of subroutines were developed to interface between the Visual Basic
GenScn code and the existing FORTRAN routines. This allowed the well-tested and well-documented
WDM code to be preserved. During development of GenScn, it was necessary to incorporate different
types of time-series data (that is, storage and model formats). To make GenScn work with these different
data types in a consistent manner, a generic data structure was developed. Specific routines for each data
type were written to fill the data structure. GenScn was then able to use this data structure in the same
manner for all types of data.

Several other analysis tools were developed using existing FORTRAN codes that had already been tested
and documented. The codes were compiled into Dynamic Link Libraries (DLLs) and then called by
GenScn using new code that interfaces to the DLLs. The Duration and Compare analyses were both
developed using this method. Another tool, Gener, that allows the generation of new time series that are
based on existing time series was also developed in this manner.
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Special Files

GenScn uses a series of files for various purposes.  Some files save the state of system functions, others
contain GIS and time-series data, while others provide error and warning messages.

The Appendix provides detailed descriptions of each of these files and their contents. The following is a
list of the files documented in the Appendix:

• Project Status - *.sta

• Map Specifications - *.map

• Error and Warning Message - ERROR.FIL

• Time-Series Buffer - *.tsb

• Compare Specifications - *.gco

• Duration Specifications - *.gdu

• Animate Specifications - *.gan

• Full Equations (FEQ) Model Output - *.feo

• Relational Data Base - *.rdb

• HSPF Message WDM

• HSPF Status

• Time-Series WDM - *.wdm

Sample Data

Sample data have been provided with the GenScn installation package for learning and demonstration
purposes. No assumptions are to be made concerning the accuracy of the data, including the time-series
WDM file, the Geographic Information System (GIS) files for mapping, the project status file, and the
HSPF User Control Input (UCI) files.
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Tutorial

This section presents detailed examples illustrating the use of GenScn in various project situations. The
most effective way to use this section is by running GenScn and working through the lessons. This
assumes that GenScn and its associated example data have been installed on your computer. For
instructions on how to obtain and install GenScn, see the Obtaining GenScn section. The examples
assume that GenScn is started at the beginning of each lesson and closed at the end of each lesson. This
will ensure that the examples correspond with what the user sees while running the tutorials.

• Lesson 1 is an introduction to GenScn and time-series selection.

• Lesson 2 shows how to build simple time-series plots.

• Lesson 3 shows how to list time-series data.

• Lesson 4 shows how to perform a duration analysis.

• Lesson 5 describes how to build a new scenario and run it.

• Lesson 6 shows how to compare two scenarios.

• Lesson 7 shows how to create a new project and import data.

• Lesson 8 describes how to generate time-series data.

• Lesson 9 explores advanced graphics features.

• Lesson 10 explores advanced mapping features.
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Lesson 1: Introduction and Time-Series Selection

In this lesson, GenScn will be started and a project opened. The main GenScn form will be explored
along with the help system. Exercises will then show different methods for selecting time series of
interest for further review and analysis.  To start GenScn, double click the GenScn icon on the desktop
with the mouse or single click on the GenScn icon on the Start Menu. The main GenScn form appears:

The main GenScn form is divided into six frames and a menu bar. The menu bar allows keyboard
shortcuts for most commands. Holding the Alt key down while typing the underlined letter in the desired
menu title displays the menu items under that title. Typing the underlined letter of the desired menu item
then selects that item. The mouse may also be used to select menu items. Each of the six frames is named
in the upper left corner.

At any time when GenScn is being run, the complete manual is available online. To access the manual,
simply press the F1 key. This command brings up the GenScn online manual open to a section
appropriate to the current situation.

The first step in this lesson is to learn how to open an existing GenScn project. (Lesson 7 provides an
example of how to create a new project.) Holding the Alt key down and pressing the F key (ALT-F)
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shows the menu items for the File menu title. Pressing the O key brings up the GenScn File Open Project
form (the mouse may also be used) similar to the one shown:

This is a file open common dialog. Select the ‘Shena’ folder to move to the sample project directory.
Next select ‘Shena.sta’ to open the sample project. The project file is read and the main GenScn form is
updated with the sample project as shown:
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The Map frame contains a map of the basin, a toolbar containing map manipulation commands and a tab
strip containing a legend and summaries of information found on the map.  The Map Toolbar contains
various map manipulation tools.

The Scenarios frame contains a list of the scenarios available in the project. Select the OBSERVED entry
by clicking on it.

The Constituents frame contains a list of the names of the constituents available in the project. Select the
FLOW entry.

In the locations list found in the Locations tab (below the map, next to the Legend tab), select the
‘LYNNWOOD’ entry by clicking on it. The entry highlights and the corresponding marker on the map
changes to red. This is the location of Lynnwood. Click on the red marker and note that it changes back
to its original color and Lynnwood is deselected in the locations list. Click on Lynnwood again to select
it.

The Time Series frame contains information about currently selected time series along with selection
tools. We have selected one location (LYNNWOOD), one scenario (OBSERVED) and one constituent
(FLOW). Click on the Add  button to add any time series that match these criteria. Note that WDM

time-series dataset 139 contains OBSERVED FLOW data at LYNNWOOD.

The Dates frame contains information about the range of dates available for the currently selected time
series. For our selected time series, data are available from January 1, 1984, to December 31, 1993.
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The Analysis frame contains a toolbar that links to GenScn’s analysis tools. Later lessons will describe
how to use these analysis tools.

Resume this lesson by clearing the list of selected time series. This is done by clicking on the Clear 

button in the Time Series frame (third from the left). (This can also be done by clicking on time-series
dataset 139 in the list to highlight it and then clicking the Remove  button). Now that we know there

is observed flow data at Lynnwood, let us see if there is any more at other locations. Leave OBSERVED
and FLOW selected as the scenario and constituent, but now click on the ‘All’ button in the Map frame.
Note that seven locations are now selected, which indicates that there is observed flow data at the seven
locations. These locations are indicated by the red triangles on the map and are also highlighted under the
Map locations list. The locations list must be scrolled down to see the seventh location, Dooms. Add
these seven locations to the list of selected time series by clicking on the Add  button in the Time

Series frame.
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If these were time series that would be used frequently in GenScn, then they could be saved to a file for
retrieval at a later time. Do so by clicking on the Save Time Series  button in the Time Series frame

(third button from the right). A file open common dialog form is displayed that prompts for the name of a
file in which to save the list of time series. Enter a file name (the .tsb extension will be added
automatically) and click the ‘Save’ button. This set of time series (and the scenario, location, constituent
selections that generated it) may be retrieved at any time by clicking the Get Time Series  button just

to the right of the Save Time Series  button.
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Finally, we will learn how to determine what data are available at a specific location. Begin by again
clearing the list of time series by clicking the Clear  button in the Time Series frame. Next clear all

selections in the Location frame by clicking on the ‘None’ button.  Click on the ‘All’ buttons in Scenario
and Constituent frames.  Select the CHRISTIA location in the locations list by clicking on it. Note that in
the Scenario and Constituent frames there are option buttons for listing All items or Location-only items.
In each frame, select the Location option by clicking on it. The lists in the Scenario and Constituent
frames now display only those items that are found at the selected Location(s). Thus, we see that
CHRISTIA has data for all of the available scenarios, but it only has data pertaining to the FLOW
constituent.  Click on the Add  button in the Time Series frame to see the specifics of the time series

found at CHRISTIA.

Exit GenScn by selecting the Exit menu item from the File menu title or clicking on the X in the upper
right corner of the main form.
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Lesson 2: Time-Series Graphics

In this lesson, GenScn will be used to build a simple time-series plot and customize it. Start GenScn,
open ‘Shena.sta’, select OBSERVED FLOW at LYNNWOOD and add the time series to the list (see
Lesson 1 to learn how to do this). Next click the Graph  button on the Analysis Toolbar.  The Graph

form will appear.

Note that only the Standard and Flow/Duration Plots are available. This is because only one time series
has been selected. Click on the ‘Generate’ button. A graph of the selected time series appears.



Lesson 2: Time-Series Graphics 21

Note that the graph spans the 10-year period shown in the dates window (1984-93).  There are a lot of
data on this graph. To make the graph fill the entire screen, click on the box in the upper right corner
(next to the X).  There are still lots of data.

Let us look at just a single year of data--1987.  First, close the 10-year graph by clicking on the ‘X’
button in the upper right corner of the graph, then click the ‘Cancel’ button in the graph generation form.
Next, click in the Start year box of the Dates frame. Type the number ‘1987’.  Then click in the End box
and type the number ‘1987’ again.  Click the Analysis Graph  button to bring up the Graph window.

Click on the ‘Generate’ button.  The following graph appears:
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The low flows are difficult to make out. A logarithmic Y-axis will show them better. Type ALT-EA to
bring up the Graph Edit Axes window.
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Click on the logarithmic radio button in the Left Y-axis frame. Then click the ‘OK’ button. The graph is
automatically refreshed.

To print a copy, type ALT-FP. A print common dialog appears. If the defaults are correct, click on the
‘OK’ button to print the graph.

Close GenScn by clicking on the ‘X’ button in the upper right corner of the main window.
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Lesson 3: Time-Series Listing

In this lesson, GenScn will be used to build a simple time-series listing and customize it. Start GenScn,
open ‘Shena.sta’, select OBSERVED FLOW at LYNNWOOD and add the time series to the list (see
Lesson 1 to learn how to do this). Remember from lesson 2 that this spans the 10-year period shown in
the dates frame (1984-93).  Let us look at monthly averages.  Click on the Tstep, Units box of the Dates
frame. Use the down arrow to move to a Month time unit.  Next click the List  button on the Analysis

Toolbar.  A form containing a monthly listing of the data will appear.

The GenScn List form may be removed by clicking on the ‘X’ button in the upper right corner of the
form.
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Lesson 4: Duration Analysis

In this lesson, GenScn will be used to perform a simple duration analysis. Select OBSERVED FLOW at
LYNNWOOD (see Lesson 1 to learn how to do this). Next click the Duration  button on the Analysis

Toolbar.  The Duration form will appear. This is the DURANL module from HSPF and should not be
confused with the traditional flow duration analysis that is a cumulative frequency curve of a continuous
time series.

Click ‘Clear Specs’ to initialize a new duration analysis.  Click on the Durations tab to bring it to the
foreground. Click the ‘1’ in the Available list and then the ‘-->’ button to move the ‘1’ into the Active
list. Click in the box below the Available list and enter the number ‘7’. Click the ‘-->’ button to move this
value to the Active list. The two numbers in the Active list indicate that this analysis will look for events
of 1 or 7 time units (in this case, days) in duration.



Lesson 4: Duration Analysis26

Click on the Thresholds tab to move the Thresholds tab to the foreground.  Click on ‘Logarithmic’ in the
Defaults frame, and notice that the Available list changes to a logarithmic series from 1 to 10000.  Click
on the ‘>>’ button to move all of these values to the Active list.

Click on the ‘Compute’ button to begin the duration analysis computations.  The ‘Results’ button will
become active when the computations are complete.  Click on the ‘Results’ button to see the results of
this duration analysis.
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The GenScn Duration Results form displays the results one page at a time. At the bottom of the form
there is a set of buttons and numbers that allow the user to move through the file. Click on the buttons to
move forward or backward through the file, or enter a specific page number to see that page of results.
When finished viewing the results, click on the ‘Close’ button in the Results form, and then click on the
‘Close’ button in the Duration form. Exit GenScn.
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Lesson 5: Scenario Creation and Execution

In this lesson, GenScn will be used to create a scenario and execute it.

Start GenScn, open ‘Shena.sta’, then select the BASE scenario from the Scenarios list. Click on the
‘Activate’ button. GenScn will activate the BASE scenario, a process that takes several seconds. During
this process the GenScn Activate HSPF form will appear.

When GenScn has completed the Activate process, the Activate form will appear.
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To demonstrate how one might create a scenario, we will make a small change to this existing scenario
and save it under a new name.  Click on the ‘EXT SOURCES’ list item in the block frame. For more
details see the section Edit Scenario.

Notice that when ‘EXT SOURCES’ is clicked, the Activate form expands and the External Sources block
of the HSPF input sequence is displayed. For this example we will reduce the precipitation for the area
by one-half. On each line of the grid having ‘HPRC’ in the SMEMN column, enter the value 0.5 in the
MFACTR column. After entering the value 0.5 for each precipitation external sources record, click on
the ‘OK’ button to accept these changes. It is a good idea to edit the Run Info field so it describes the
new scenario.
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Click on the ‘Save As’ button to save this scenario under a new name. Enter the name ‘HALFPRCP’ as
the new scenario name in the GenScn Activate SaveAs form, then click the ‘OK’ button to continue. A
file by this name, with a .uci extension, will be created as an input sequence for HSPF. Timeseries
created for this new scenario will be numbered using available data-set numbers after 1000.

Notice that the GenScn Activate form title now contains the name of the scenario, HALFPRCP.
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Click on the ‘Simulate’ button to run the HSPF simulation.

The HSPF form will appear and show the status of the simulation.  After the simulation is complete, click
on the ‘Close’ button to return to the main GenScn form.

A new scenario has been created and executed.  The scenario list
should now contain this new scenario.  Explore the results of the
new scenario using the information learned from previous
exercises.  When finished, delete this new scenario using the
‘Delete’ button under the scenario list, then exit GenScn. For more
details on deleting a scenario see Delete in the Detailed Functions,
Scenarios section.
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Lesson 6: Scenario Comparison

GenScn provides several ways to compare two scenarios.  This lesson will focus on scenario comparisons
at one location using the Graph, List, and Compare analysis tools. Start GenScn, open ‘Shena.sta’, select
both BASE and OBSERVED scenarios, constituent FLOW, and location LYNNWOOD, then add the
time series to the list (see Lesson 1 to learn how to do this).

Click the Graph  button on the Analysis Toolbar.  The Graph form will appear and show the list of

available graph options.  The Standard plot will be selected.  Click on the ‘Generate’ button and a time-
series plot will be displayed for OBSERVED and BASE FLOW at LYNNWOOD.  Notice how one
might observe the differences between the observed and base scenarios.

Use the File:Close menu item to remove this plot, and click the ‘Cancel’ button in the Graph form.
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Another useful way of comparing scenarios is using the List tool. Click the List  button on the

Analysis Toolbar.  The List form will appear and show each data point in the two time series.  After
viewing this list, use the File:Close menu option to remove this list.
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Now click the Compare  button on the Analysis Toolbar to explore how the Compare analysis tool

can be used to provide statistical comparisons of two scenarios.  The Compare form will appear.

Click on the ‘Clear Specs’ button to initialize a new compare analysis.  The Class Limits tab should be in
the foreground.  Click on ‘Logarithmic’ in the Defaults frame, and then choose ‘6’ from the pull-down
list as the number of class limits.  Notice that the Available list changes to reflect these default values.
Click on the ‘>>’ button to move the list of class limits to the Active list.

Click on the ‘Compute’ button to begin the compare analysis computations.  The ‘Results’ button will
become active when the computations are complete.  Click on the ‘Results’ button to see the results of
this compare analysis. The GenScn Compare Results form displays the results one page at a time.  At the
bottom of the form there is a set of buttons and numbers that allow the user to move through the file.
Click on the buttons to move forward or backward through the file, or enter a specific page number to see
that page of results.
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When finished viewing the results, click on the ‘Close’ button in the Results form and then in the
Compare form, then exit GenScn.
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Lesson 7: Project Setup

In this lesson, GenScn will be used to set up a project in a new basin.

The first step in setting up GenScn for a new basin is to prepare the GIS coverages for the map. For
details on setting up the GIS files for GenScn, see the section entitled GIS Data in the Setting Up a New
Scenario Generator section. Once these coverages have been prepared, the map file must be created using
a text editor. An existing map file may be modified or a new map file may be created as detailed in the
Map Specifications appendix. For the purposes of this tutorial, the user may wish to copy the file
‘Shena.map’ provided with GenScn to ‘Demo.map’. Make sure the GIS files referred to in the map file
are where the map file expects them. Each layer in the map should have an associated file with extension
SHP and another with extension DBF.

Assuming the GIS files for the map are now prepared, the user may now begin setting up a new project.
With no project open, click on the ‘File’ menu and select the ‘New Project’ menu option.

The GenScn Manage Project File form will appear. Click the ‘Select’ button next to ‘Map File’, and
select the new map file created above. Next click the ‘Select’ button next to ‘Timeseries WDM File’, and
specify the name of a new WDM file, such as ‘Demo.wdm’.
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When the ‘OK’ button is clicked, the GenScn Manage Project File form will disappear, giving way to the
main GenScn form that contains only the map and the OBSERVED scenario. No time series exist as yet,
and no scenarios have been created.
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Select the OBSERVED scenario from the scenario list and then click the ‘Activate’ button. The GenScn
Activate OBSERVED form will appear, from which the user picks the input data format. Select the
Watstore Daily Values format, and then click the ‘OK’ button.

The Watstore form will appear, from which the user may import the observed time-series data.  For more
details on using this option, see the Activate in the Detailed Functions-Scenario section.  For this tutorial,
if no Watstore data are available, click the ‘Cancel’ button to continue.
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After importing the observed time-series data, the user may create a new scenario by clicking the ‘New’
button in the Scenario frame on the main form. The GenScn New Scenario form will appear, from which
the user can specify the parameters related to the new scenario.

Once the input parameters have been specified, click the ‘Process Files’ button.  The summary tab will
appear showing details of the scenario about to be created.  Then the user may click the ‘Build UCI’
button to create the new scenario.
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See the section New Scenario in the Detailed Functions section for more details on building, processing,
and summarizing a new scenario. Click the ‘Close’ button to return to the main GenScn form. At this
point the user has completed the setup of a new project. From the File menu title on the main form, select
the ‘Save Project As’ menu item to save this new project, then exit GenScn.
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Lesson 8: Generating Time Series

In this lesson, GenScn will be used to generate new time-series data. Start GenScn and open ‘Shena.sta’.
Click the Generate Timeseries  button on the Analysis Toolbar.  The Generate form will appear.

The Compute operation will be chosen initially.  Assume the user would like to convert a time series of
values in inches to centimeters.  Choose the ‘*C’ item from the Function frame.  Click in the Constants
field and enter 2.54 in this field.  In the Timeseries, frame click in the Dsn field for Input Timeseries 1
and type the number 705.  Press the tab key and notice that the scenario, location, and constituent names
become visible for this time series. Click in the output time-series dsn field and enter the number of a
time series that does not yet exist (706 works for this tutorial).  Press the tab key and enter ‘TEMP’ as the
scenario name, ‘SEG190’ as the location name, and ‘PREC-cm’ as the constituent name.  We will
generate this new data set for every time step of the source time series, so there is no need to adjust
anything in the dates frame.  Click on the ‘Perform Operation’ button to begin the generate operation.  A
message form will be displayed when the operation is completed.
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Click on Transform to change to the Transform operation. Assume the user would like to convert a time
series of hourly values to maximum monthly values. In the Timeseries frame, click in the Dsn field for
Input Timeseries 1 and type the number 705. Press the tab key and notice that the scenario, location, and
constituent names become visible for this time series. Click in the output time-series dsn field and enter
the number of a time series that does not yet exist (707 works for this tutorial). Press the tab key and
enter ‘TEMP’ as the scenario name, ‘SEG190’ as the location name, and ‘MONMAX’ as the constituent
name. In the time units pull-down list, change the time units to Month, and in the pull-down list below
the time units, change the transformation function to Max. Click on the ‘Perform Operation’ button to
begin the generate operation. A message form will be displayed when the operation is completed.
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Click on Manual to change to Manual operation.  Assume the user would like to add values for 10 days
to a time series.  In the Timeseries frame, click in the Dsn field for the output time series and type the
number 706.  Press the tab key and notice that the scenario, location, and constituent names become
visible for this time series.  In the function frame, click the ‘Use this value for all’ option and enter a
value of 0.1 in the Value field.  Change the ending date to 1992-1-10.  Click the ‘Perform Operation’
button to begin the generate operation.  A message will be displayed when the operation is completed.

The 'Interpolate to this value' option is used to interpolate from a value in the time series to an entered
value. For example, to add 10 daily values to this time series increasing to a value of 2.0, the user can
choose the 'Interpolate to this value’ option with 2.0 in the Value field. The start date should be set to the
end of the existing data, and the end date should be set 10 days later. Clicking the 'Perform Operation'
button will add 10 values to this time series, the last value being 2.0.

To enter a different value for each of the 10 days, the 'Use this value for all' option can be used 10 times
with an end date one day after the start date. For each day, enter a number in the Value field, then click
the 'Perform Operation' button. The end date will default to one time step after the previous end date.

During this lesson two time series were created.  Use the List analysis tool to investigate the output from
these generation operations.  When finished looking at these time series, they can be deleted by deleting
the ‘Temp’ scenario on the main form. Exit GenScn when you are finished.
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Lesson 9: Advanced Graphics

In this lesson, GenScn will be used to build a set of complex plots and customize them.

Start GenScn, open ‘Shena.sta’, select both BASE and OBSERVED scenarios, constituent FLOW, and
location LYNNWOOD, then add the time series to the list. (see Lesson 1 to learn how to do this). In the
dates frame change the starting year to 1987, and change the time units to Months.

Click on the Graph  button in the Analysis tool bar. The Graph form will appear. Click off the check

box for Standard and click on the check box for Bar Charts.
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Click the ‘Generate’ button.  A Bar Chart will appear for the BASE and OBSERVED scenarios for
monthly mean flow values in 1987 at Lynnwood.

From the Edit menu title in the Graph form, select the Curves menu item. Assume the user wants to
change the color of the Observed lines. In the Graph Edit form, change the curve number to 2, and
change the color to ‘ltred’.
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When the ‘OK’ button is clicked, the Bar Chart will appear with the Observed lines in light red.
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By default, the two scenarios are distinguished by color only. If these colors are not reproduced above,
the left bars correspond to the base scenario and the right bars correspond to the observed scenario. After
observing this graph, click the ‘X’ in the upper right corner of the Bar Chart form to close it and return to
the ‘Graph’ form. Check off the Bar Chart and check on the Flow/Duration. Click the ‘Generate’ button
to create the Flow/Duration plot.
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Notice that a line on the plot has been drawn through the legend. From the Edit menu title select the
General menu item. Click on the Specify radio button for the Legend Location. Then enter 0.7 as the x
position and 0.9 as the y position.
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Click the ‘OK’ button and notice that the legend has moved to a new location on the plot.
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Now in the Graph form select Scatter, and then check the 45 degree and regression lines. Click on the
‘Generate’ button.
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A scatter plot is produced with a regression line fitted through the data points. The equation of the
regression line is included on the plot as well as the correlation coefficient from the regression. By
default, the equation is displayed using X for the horizontal axis and Y for the vertical axis. The equation
and coefficient text can be edited or moved with the General menu item in the Edit menu. This makes it
possible to change X and Y into more descriptive names. The axis titles can be edited using the Titles
menu item in the Edit menu. Clicking on a title is another way to bring up the Edit Titles window. If
quantities being graphed have units, for example, the units should be added to the axis labels.

Many other graph options have not been discussed in this lesson. The user might wish to continue
exploring the different graph features. Close the graphs and exit GenScn when finished exploring.
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Lesson 10: Advanced Mapping

In this lesson, GenScn will be used to customize map views in a project. There are several ways a user
might customize a map. For this lesson, assume the user wants to zoom in on the map, change the layers
displayed on the map, and change the color used for a map layer.

First, make sure a project is open and a map is displayed. Click on the zoom  button from the map

toolbar. Move the mouse to the map and click and hold the mouse button at one corner of the desired
region. Stretch a box to the opposite corner of the desired region and then release the mouse button.

The map will zoom to the region of interest.
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If the Legend tab is not on top in the tab strip below the map, click to the Legend tab.  A legend will be
displayed, showing the layers on the map and their corresponding colors.

Click the Edit Layers  button above the map or click inside the Legend tab. The Edit Map Display

Attributes form will appear. Click the county lines Map checkbox, labeled ‘cnty.’ This box determines
whether or not the county lines are drawn on the map.
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Click on the fill color box for cataloging units, labeled ‘cat.’ The Color dialog will appear, from which
the user can choose a new color for the cataloging units map layer. Select the desired color by double-
clicking or by clicking the ‘OK’ button in the Color dialog.

Click the ‘OK’ button in the Edit Map Display Attributes form. Notice that the map is redrawn with the
cataloging units color changed and the county lines are now visible (or, if they were visible before, they
are now gone.)
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This map view can be saved using the Save  button on the map toolbar. A map view can be retrieved

at a later time using the Get  button on the map toolbar. Many other map customizations are possible.

See the Map section in the Detailed Functions section for more details. This concludes the introductory
tutorial.
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Detailed Functions

File

When no project is active, the available menu items under the File menu title are the New Project and
Open Project items.

After a project is open, the available menu items are Edit Project, Close Project, Save Project, Save
Project As, and Exit.

In order to switch between projects, the open project must be closed before another project can be
opened or created.
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New Project

The File:New Project menu item allows the creation of a new project status file.

The three ‘Select’ buttons bring up file open common dialog boxes. First, a map specifications file must
be specified. This file contains information about the map associated with the basin.  Second, the location
of the HSPF Message file must be confirmed. Third, a Time-Series WDM file must be specified. All
three of these files must exist, with the exception of the Time-Series WDM file, which will be created if
it does not exist.

If RDB or FEO files are to be associated with the project, they should be specified through use of the
appropriate ‘Add’ button.

The ‘OK’ button refreshes the GenScn main form and returns control there.  The ‘Cancel’ button returns
control to the GenScn main form without refreshing it.
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Open Project

Selection of the File:Open Project menu item causes a file open common dialog box to be opened.

Selection of a project status file in this dialog box causes an existing GenScn project to be opened. The
GenScn main form will refresh with a summary of the selected project.

Close Project

The File:Close Project menu item closes the currently active project.  If the project status file has been
edited, the user is asked if the edited file should be saved.

A ‘Yes’ button response will overwrite an existing project status file if one exists. Otherwise, a status file
name will be requested.  The ‘No’ button response will close the project without saving the edits to the
status file.  The ‘Cancel’ button response will cancel the File:Close Project action.  This is useful when a
project status file has been edited and needs to be saved with a new name (see Save Project As).
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Edit Project

The File:Edit Project menu item allows editing of the project status file. The three ‘Select’ buttons bring
up file open common dialog boxes. The location of the map specifications, HSPF Message, and Time-
Series WDM files may be updated.

RDB or FEO files may be added or removed from the project by use of the ‘Add’ button or ‘Remove’
button associated with the file type list.

The ‘OK’ button refreshes the GenScn main form and returns control there.  Pending changes to the
project status file are not permanent until the File Save Project menu item is selected. The ‘Cancel’
button returns control to the GenScn main form without refreshing it. Pending changes to the project
status file are ignored.
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Save Project

Selection of the File:Save Project menu item overwrites the current project status file. If there is no
current project status file, the ‘Save Project As’ dialog will appear.

Save Project As

Selection of the File:Save Project As menu item causes a ‘Save Project As’ dialog to appear.
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Exit

The File:Exit menu item closes the currently active project (if any) and exits GenScn. If the project status
file has been edited, the user is asked if the edited file should be saved.

A ‘Yes’ button response will overwrite an existing project status file if one exists. Otherwise, a status file
name will be requested.  The ‘No’ button response will close the project without saving the edits to the
status file.  The ‘Cancel’ button response will cancel the File:Exit action.  This is useful when a project
status file has been edited and needs to be saved with a new name (see Save Project As).
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Map

A map of the river basin being analyzed is provided to visualize the spatial distribution of important
features, such as rivers and streams, drainage boundaries, and political boundaries. The map allows the
user to identify locations where time-series data are available and to select desired locations for analysis.
A map toolbar and a corresponding menu title are provided to allow the user to manipulate the map in a
variety of ways.
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Map Toolbar

The Map Toolbar contains buttons which allow the user to change the map extent     ,

get information  about points on the map, edit the display , add points  to the map, move

points  on the map, save  or get  map specifications, and print  a copy of a map.

Zoom, Pan, Full Extent

The leftmost grouping of five buttons on the map toolbar are used to display desired map extents.  The
Zoom  button allows the user to specify an area of the map to display by drawing a box around the

desired area. This is done by clicking and holding down the left mouse button in one corner and then
dragging the pointer to the opposite corner and releasing the mouse button when the box is defined.  The
Zoom In  button causes an incremental zoom to a smaller portion of the map.  The Zoom Out 

button causes an incremental zoom to a larger portion of the map.  The Pan  button is used to pan left,

right, up, and down on the map extent. This is done by clicking and holding down the left mouse button
on the map and moving the map in the desired direction. The scroll bars on the right and bottom of the
map may also be used to pan the visible portion of the map.  The Full Extent  button is used to

display the full (largest available) extent of the map.

Identify

The Identify button is used to enter identify mode. This mode is indicated by having a “?” symbol
attached to the pointer. In identify mode, a label is displayed just below the cursor for the map feature
nearest to the cursor. The currently selected table below the map is the layer being identified. The table is
automatically scrolled so the line of the table containing information about the closest map feature
appears at the top of the table. The database field used for these labels can be changed in the Labels
form, accessed through the Edit Map Display Attributes form.

While on the map, the mouse pointer will remain in identify mode until another button on the map
toolbar is selected or the right mouse button is clicked.
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Add Point

The Add button is used to add a new point to a point coverage of the map. Before a point can be added,
the table for a point coverage must be selected below the map. After clicking the Add button, a point is
added by clicking the left button on the map where the new point is to be placed. The user will then be
prompted for a name for the point. A new point can not be selected for use until data associated with that
point is available.

Move Point

The Move  button is used to move a point within the point coverage of the map. Points are moved by

dragging. This is done by clicking and holding down the left mouse button over a point, moving the
mouse to the desired location, then releasing the mouse button. Points may also be moved by using
ArcView, or any other GIS software which can manipulate shape (.shp) files.

Save Map

The Save Map button is used to save the current map settings to a  map specifications file or to save an
image of the map to a file or to the clipboard as a bitmap or Windows Metafile. The user will be
prompted for the file name through a file open common dialog. Map settings include the current map
extent and the coverages (and their characteristics) displayed. Once the map settings are saved they can
be retrieved at any time during this or any other GenScn run using the Get Map Specifications 

button. The Save as Type list in the save dialog is used to save an image of the current map. After
choosing a format, the file name should end with the appropriate extension for that format, as indicated
in parentheses in the Save as Type blank.

Get Map Specifications

The Get Map Specifications button is used to retrieve previously saved map settings from a  map
specifications file. The user will be prompted for the file name through a file open common dialog. Map
settings include the current map extent and the coverages (and their characteristics) displayed. The
retrieval of the map settings allows the user to recall a specific area of interest or a desired combination
of coverages.
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Print

The Print Map button causes the map to be sent to the currently selected printer. No printer dialogue is
displayed for selecting the printer, so the user should select the system printer from the operating system
(if needed) before printing the map. For a black and white printer, gray scales will be used to indicate
colors on the map.

Edit Map Display Attributes

Clicking the Edit Layers button on the toolbar or clicking inside the legend will cause the Edit Map
Display Attributes form to appear. This form displays all of the current coverages and their colors and
styles.

The Layer column displays the name of the database containing each layer. The Type column displays P
for a point layer, L for a line layer such as rivers, or A for an area layer. In the Caption column, the text
used to identify each table can be edited.

Clicking a check box in the Map column will change whether or not a layer will appear on the map.
Table check boxes determine whether or not a table is displayed in a tab below the map. Checking a
Table check box will cause the Table Columns form to appear so columns from the database can be
selected for display. Clicking the ‘Table’ button while a layer is selected is another way to check a Table
check box. Label check boxes are similar to Table check boxes. Checking a Label check box causes the
Labels form to appear so the source and style of labels can be adjusted.

Clicking on the color patches next to a coverage will cause a color palette form to appear that will allow
selection of the desired color for that coverage. Clicking on the Style list allows the user to modify the
style of the coverage. Clicking the ‘Renderer’ button while a layer is selected causes the Renderer form
to appear so different colors and styles can be used depending on data. When a renderer is in use, the fill
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and outline colors and style that appear on the Edit Map Display Attributes form will only be used for
features that can not be drawn by the renderer. This usually happens because there is incomplete data in
the shape database describing the features.

The currently selected layer is indicated by a rectangular outline. Clicking on any part of a row of
information selects that layer. The layers are displayed in the order in which they appear on the map. The
bottom layer in the list is drawn first and the top layer in the list is drawn on top of all the other layers.
The ‘Up’ button and the ‘Down’ button move the currently selected layer up and down in the drawing
order.

The ‘Add’ button uses a file open common dialog to locate an ESRI shape file to add to the map. The
‘Delete’ button removes the currently selected layer from the map. Changes to the coverages and their
colors and styles will not take effect until the ‘OK’ button is clicked. Clicking the ‘Cancel’ button will
nullify any changes to the map that had been specified.

Table Columns

Each row in this form corresponds to a field in the shape database and can be displayed as a column in a
table below the map. Column labels can be edited in the Label text boxes and columns are selected for
inclusion in the table with the Table check boxes. The ‘Up’ button and the ‘Down’ button can be used to
change the order of the fields.
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Labels

The Label Field in DBF control selects which database field to use for labeling. The same field will be
used for the labels that appear in identify mode. The Key Field in DBF control sets the field to use for
selecting features. This will typically be IDLOCN for locations. Vertical and horizontal alignment of
labels can be customized. The ‘Font...’ button will cause a common dialog to appear for specifying the
size, color, and style of labels.

Legend

The Legend tab below the map displays the meaning of the coverages on the map. Coverage symbols and
their colors are displayed with a descriptive name next to each coverage.
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Locations

The Locations tab in the Map frame of the GenScn form displays available and selected location names
in a project. Details of the point coverage on the map are displayed in the columns adjacent to the list of
names. The columns displayed are specified in the map specification file and can be edited in the Edit
Map Display Attributes form. Selected locations are highlighted in the list of names. Available and
Selected locations are also shown on the Map. Selection or deselection in this tab updates the map and
vice versa.

The summary label in the upper right corner of the Map frame shows a count of the locations that are
selected and available. The ‘All’ button is used to select all available locations. The ‘None’ button
deselects all locations. A location can only be selected after associated scenarios and constituents have
been selected. If there is no data available at a location for the selected scenarios and constituents, it can
not be selected.

Depending on what selections are made in the Edit Map Display Attributes form, other tabs may be
present containing information about other map layers.
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Scenarios

The Scenarios frame of the main GenScn form displays the available and selected scenario names in a
project. The summary label in the upper left corner of the frame shows a count of the scenarios that are
selected and available. The ‘All’ button is used to select all available scenarios. The ‘None’ button
deselects all scenarios. The scenario list contains an alphabetical list of available scenarios. Selected
scenarios are highlighted in this list.

Each scenario (except OBSERVED) is associated with a model. If GenScn has been connected to an
associated model (as it has for HSPF), it can be used to edit input for the model, execute the model, and
review output from the model.

The Activate scenario management button brings up a summary of the scenario in the context of the
available model. For the observed scenario this button will bring up a form from which the user may
import additional observed time-series data. For a scenario associated with the HSPF model, information
associated with the UCI file is displayed with a set of action buttons.

The Delete scenario management button removes the selected scenario from the project and deletes its
associated time series.

The New scenario management button creates a new scenario based on information provided by the user.
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Activate

The Activate scenario management button brings up a summary of the scenario in the context of the
available model. For the observed scenario this button will bring up a form from which the user may
import additional observed time-series data. For a scenario associated with the HSPF model, information
associated with the UCI file is displayed with a set of action buttons.

The Path field on the activate form associated with HSPF is used to specify the path to the UCI file. The
default is no path, meaning that the UCI file is in the same folder as the project file. The Run Info field
may be used to document any information about this scenario.

The Simulate button is used to run the associated model for the active scenario. The Modify button is
used to make changes to the run using a special translator available only for select applications.

The ‘Save’ button is used to save the active scenario and associated UCI file after changes have been
made. The ‘Save As’ button is used to save the active scenario and associated UCI file under a new
name, resulting in an additional scenario in the Scenarios list on the main form. When this new scenario
is created (using the Save As option), the time series associated with it will be saved to a new set of data-
set numbers on the WDM file.
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The ‘Save As’ form contains a field for the user to enter a base data-set number and a set of option
buttons indicating if the numbering should be absolute or relative. With absolute numbering, data sets in
the new scenario will be assigned the next available data-set number following the number entered. Thus
if 1000 is entered and absolute is selected, new data sets will be created starting at 1000 (or the next
unused number after 1000 if 1000 is already in use). With relative numbering, data sets in the new
scenario will be assigned available data-set numbers following the number entered plus the data-set
number of the corresponding data set in the base scenario. Thus if 1000 is entered and relative is
selected, data set 120 from the base scenario will be saved as data set 1120 (or then next available
number, if 1120 is already in use) in the new scenario.

The ‘View Echo’ button and ‘View Output’ button are used to view the Echo and Output files for the
active scenario, respectively. These two files correspond to the files produced during an HSPF run. The
‘Close’ button is used to close this form and return to the main GenScn form.

The ‘Block’ frame is used to make changes to the UCI file for this scenario. The list in the ‘Block’ frame
contains each block of the UCI file. The ‘All’ and ‘Active’ radio buttons can be toggled to show all
available UCI file blocks or only those that are active in the current UCI file. Clicking on any block name
will result in the ‘Activate’ form expanding to include details related to that block or subtables within
that block. See Edit for more details.
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When the OBSERVED scenario is activated, a form appears from which the user can choose a format for
importing new OBSERVED data. Three choices are available: Watstore Daily Values, Watstore Unit
Values, or RDB (relational data base). The Watstore Unit Values format is not yet supported, however
GenScn is capable of working with unit values in already-existing WDM data sets.

After selecting one of the formats and clicking the ‘OK’ button, a form appears from which the user can
specify parameters related to the import data.

For Watstore Daily Values, the ‘Select’ button is used to select the input file containing the time-series
data. The ‘Begin’ button is used to begin reading the input file. Any number of data sets may exist
sequentially in the input file, and the Activate function will move through these data sets one at a time.
For each data set the user may enter parameters including the Scenario, Location, and Constituent
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attributes, and then click on either the ‘Save’ button or the ‘Skip’ button. The ‘Save’ button will save the
time series to the WDM file, while the ‘Skip’ button will merely move on to the next time series in the
input file. Once the end of the input file is reached, the user may specify another input file, or click on the
‘Cancel’ button to return to the main form.
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For RDB Values, the ‘Select’ button is used to select the input file containing the time-series data. The
‘Select Column to Import’ field is used to select from among several columns of data that might exist in
one RDB file. The user may enter parameters including the Scenario, Location, and Constituent
attributes, and then click on the ‘Import’ button to save the time series to the WDM file. Once the end of
the input file is reached, the user may specify another input file, or click on the ‘Cancel’ button to return
to the main form.

Edit Scenario

The input sequence for a scenario associated with HSPF can be edited from within the GenScn Activate
form by clicking on a name in the list within the block frame.  Two different results are possible from
such a click, as illustrated below.

In the first case, clicking on a block name will result in the Activate form expanding to include
parameters that may be modified for that block.  The user may modify these parameters as desired, and
then click on the ‘OK’ button to return these changes to the input sequence.  Clicking the ‘Cancel’ button
will return control to the block list without keeping the changes made to that block. The ‘Help’ button
brings up context-sensitive help from the help manual for the HSPF model.
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In the second case, clicking on a block name will result in another list appearing in the Activate form.
This list appears for those blocks that contain subtables within that block.  This table list behaves much
like the block list, where a click on one of these table names results in the Activate form expanding to
include parameters that may be modified for that table.

When editing most blocks or tables, an ‘Insert’ button and a ‘Delete’ button will be available for
inserting or deleting lines from that table or block.  The ‘Text/Grid’ button toggles the display between a
spreadsheet-like grid and a plain text display of the block or table.  The ‘Dbg’ button invokes another
form that contains advance information for debugging the information in the grid.
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Modify Scenario

The Modify function is used to make changes to the model input sequence using a special translator
available only for select applications. The screens shown in this section contain data not available in the
GenScn distribution package because the Shenandoah HSPF scenarios do not use Special Actions.

Clicking the ‘Modify’ button on the Activate form causes a form to appear which contains a list of the
User Defined Variable Quantities from the Special Actions block of HSPF.

Clicking a name from this list selects this variable for editing.  With a click on the ‘Modify’ button the
form will enlarge, displaying fields defining the variable as well as fields used to edit the value and the
date/time at which the special action occurs.
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Clicking the ‘OK’ button returns control to the variable list while accepting any changes made to the
current variable specifications.  Clicking the ‘Cancel’ button returns control to the variable list without
accepting any changes to the variable’s specifications.
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Clicking the ‘Edit Descriptions’ button enlarges the form to display a list of descriptions for each
variable.  Clicking the ‘Ok’ button returns control to the variable list while accepting any changes made
to the current variable descriptions.  Clicking the ‘Cancel’ button returns control to the variable list
without accepting any changes to the variable descriptions.
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Clicking the ‘Filter’ button enlarges the form to display a filtering feature. The user may enter any text
for which to search, specify the search field (or search on all fields), and click the ‘Select From
Available’ button.  The variable list will be reduced to include only those items containing the specified
text.  The user may filter this reduced list once again (an ‘and’ condition) by using ‘Select From
Available’, or add to this reduced list (an ‘or’ condition) by using the ‘Add to Available’ button (only
available after the list has been filtered).

With the variable list active, clicking on the ‘Close’ button closes this form and returns control to the
‘Activate’ form.



Activate Simulate Activate

Scenarios80

Simulate

Simulate runs the associated model for the active scenario. The display form shows the percent
completed in a status bar.

The ‘Pause’ button is used to pause the simulation in progress. When paused, a ‘Resume’ button is
available to continue the simulation. The ‘Cancel’ button is used to cancel the simulation.
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Delete

The ‘Delete’ button removes the selected scenario from the project and deletes its associated time series.
The scenario name will be removed from the scenario list and time series with this scenario name will be
deleted. The UCI file associated with this scenario will not be deleted at the operating system level.  The
OBSERVED scenario can never be deleted.

New Scenario

The New Scenario feature creates a new scenario and associated HSPF input sequence based on
information provided by the user describing the characteristics of a watershed.  Fields near the top of the
form are used to enter information such as the name of the scenario, a text description of the scenario, the
model to be used, and the start and end dates of the run. Flags specifying the units system and the amount
of output information desired can also be set.  Currently only an HSPF input sequence may be developed
using this feature.

The user is prompted to specify the names of six sets of input parameters. These parameters may be
entered directly or through input files, which may be obtained from GIS coverages.   If values are
specified for all six sets of input parameters, this feature will develop HSPF input sequences modeling
land surface response.  If the land use and meteorological sets are not specified, GenScn will develop a
simpler HSPF input sequence for water budgeting. Instead of modeling land surface response, local
inflows are estimated using available observed flow data.  The ‘Select’ buttons in the ‘Input Files’ tab are
used to specify the file names for each of these tables.
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Once the input parameters have been specified the user may click the ‘Process Files’ button.  After a few
seconds the ‘Summary’ tab will appear with general information taken from the input parameters.  The
user may return to the ‘Input Files’ tab to make adjustments to the input parameters as desired.
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The new input sequence is generated when the user clicks the ‘Build UCI’ button. The ‘Close’ button is
used to return to the main form.  The Simplify Network button is used to simplify a large number of
model segments into a number more manageable for HSPF modeling.  The ‘Clear Specs’ button
initializes the New Scenario form, while the ‘Save Specs’ button allows the user to save the
specifications in this form to a file for later use.  These specifications can be retrieved from a file using
the ‘Get Specs’ button.

All of the input files read by this function of GenScn except the Rating Curves file must be either fixed-
format or tab-delimited.  For fixed-format input files the number of header lines in the file must be
exactly the same as in the examples below.  For tab-delimited input files the number of header lines is
flexible, but all header lines must begin with ‘/*’.  Fixed format files must use the extension ‘.inp’, while
tab delimited files must use the extension ‘.rdb’.  The Rating Curves file must be in free field format,
with at least one space between entries. The six input files are detailed below with an example of each.



New Scenario New Scenario

Scenarios84

Figure 1: EXAMPLE REACH FILE:  (format A8,7X,I5,2F10.3,2F10.2,4F10.5)

*** reach input file            elev     up      down    up      up      down    down
*** name   station    length    diff     elev    elev    lat     long    lat     long
1                1     30.43    1.00     0.00    0.00    0.00    0.00    0.00    0.00
2                1     19.53    1.00     0.00    0.00    0.00    0.00    0.00    0.00
3                1     32.06    1.00     0.00    0.00    0.00    0.00    0.00    0.00
4                1     13.98    1.00     0.00    0.00    0.00    0.00    0.00    0.00
5                1     27.80    1.00     0.00    0.00    0.00    0.00    0.00    0.00
6                1     37.01    1.00     0.00    0.00    0.00    0.00    0.00    0.00
LYNNWOOD         1     17.01    1.00     0.00    0.00    0.00    0.00    0.00    0.00

Format Columns Description
A8 1-8 Reach name
I5 16-20 Flag associating reach to a met station
F10.3 21-30 Reach Length (miles)
F10.3 31-40 Elevation difference (feet)
F10.2 41-50 Upstream Elevation (feet)
F10.2 51-60 Downstream Elevation (feet)
F10.5 61-70 Upstream Latitude
F10.5 71-80 Upstream Longitude
F10.5 81-90 Downstream Latitude
F10.5 91-100 Downstream Longitude

Each row of this table represents a reach. The reach name must consist of a character string or an integer
identification. Reach names for which an integer identification is used must be numbered sequentially.
Zero values may be used where data is unknown for elevation, latitude, or longitude, as in the above
example. The first two lines are ignored as comments.

Figure 2: EXAMPLE REACH CONNECTION FILE:  (format A8,2X,A8)

*** reach connection file ***
1         4
2         5
3         5
4         LYNNWOOD
5         LYNNWOOD
6         LYNNWOOD

Format Columns Description
A8 1-8 Reach Source
A8 11-19 Reach Target

This table contains a list of source/target pairs to indicate connections for each reach of network. The
first line is ignored as a comment.
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Figure 3: EXAMPLE CONTRIBUTING AREA FILE:  (format A8,2X,nF10.2)

reach     use 1     use 2     use 3     use 4     use 5     use 6     use 7    use 8
area      area      area      area      area      area      area     area
1         54275.00  1582.00   3663.00   15561.00  10035.00  8527.00   34.00    3566.00
2         12047.00  1645.00   3808.00   16179.00  3077.00   8866.00   0.00     1195.00
3         50977.00  3201.00   7410.00   31479.00  3182.00   17251.00  0.00     769.00
4         22797.00  691.00    1599.00   6794.00   2504.00   3723.00   0.00     514.00
5         14922.00  2737.00   6335.00   26915.00  9603.00   14750.00  1.00     3433.00
6         136620.00 4531.00   10488.00  44555.00  13953.00  24417.00  0.00     5640.00
LYNNWOOD  22338.00  2505.00   5800.00   24639.00  5331.00   13502.00  10.00    1711.00

Format Columns Description
A8 1-8 Reach name
F10.2 11-20 Area in reach dedicated to land use 1, repeated for each use (acres)

The first two lines are ignored as comments.

Figure 4: EXAMPLE RATING CURVE FILE:

# drainage area
R  100000.0
# stage   top width   xsection area  discharge
0.0        0.0         0.0            0.0
3.1        29.0        19.6           10.0
3.8        43.0        39.4           91.2
5.7        89.0        59.3           183.0
R  200000.0
# stage   top width   xsection area  discharge
0.0        0.0         0.0            0.0
3.1        29.0        19.6           10.0
3.8        43.0        39.4           91.2
5.7        89.0        59.3           183.0

The rating curves file above is a free field format, so values must be separated by at least one blank.
Comment lines can be included anywhere in the file by placing a ‘C’ or ‘#’ in the first column. The rating
curve file must have a record with an ‘R’ in column 1 (first byte) followed by the drainage area in acres
in the next 9 columns. Following the ‘R’ record are records for the rating table with stage
(elevation)(feet), top width of flow (feet), cross-sectional area of flow (square feet), and discharge (cubic
feet/second). All records must have increasing values for the numbers entered. The program can accept
up to 100 rating curves. Ratings can have up to 25 rows, but the number of rows times number of
columns in an FTABLE cannot exceed 100. The rating curves table must be developed using existing
rating curves for the region of interest or from a region with similar hydrologic characteristics.
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Figure 5: EXAMPLE LAND USE FILE:  (format A12,3X,I5)

*** land use file ***
***               ***
FOREST             1
HIGHTILL           1
LOWTILL            1
PASTURE            1
URBAN              1
HAY                1
ANIMAL             2
RESIDENT           2

Format Columns Description
A12    1-12    Land use name (8 characters are used)
I5     16-20   Flag 1=pervious, 2=impervious

Figure 6: EXAMPLE MET STATION FILE:  (format I5,5X,A8)

*** met station input file ***
1     SEG190
2     REGION4

Format Columns Description
I5     1-5     Flag 1=precipitation data, 2=evaporation data
A8     11-18   Meteorological station name

Building the UCI file

The GLOBAL and FILES blocks are produced using the general run information provided by the user.

The OPN SEQUENCE block is produced for a simulation without land surface response by ordering the
reaches in the reach file from upstream to downstream using the reach connection file. If land-surface
response is being simulated, the PERLND and IMPLND segments would precede the RCHRES segments
in the OPN SEQUENCE block. A PERLND or IMPLND segment is created for each unique combination
of land-use type and meteorologic segment. Also for land surface response, the reaches are scanned to
determine which reaches have observed data at that location, and a COPY operation is added to produce
the data sets useful for calibration at each of these locations.

If land-surface response is being modeled, a PERLND or IMPLND block will be added based on the
pervious or impervious land uses specified in the land-use file.  PERLND block tables added include
ACTIVITY, GEN-INFO, PWAT-PARM2, and PWAT-PARM4.  IMPLND block tables added include
ACTIVITY, GEN-INFO, and IWAT-PARM2.  Default values are used to fill in all values in these tables
except the segment names, which are obtained from the land-use file.  A future extension will allow other
values to be read from input files.

The RCHRES block is produced using information from the reach file. RCHRES block tables added
include ACTIVITY, PRINT INFO, GEN INFO, HYDR-PARM1, and HYDR-PARM2.  Default values
are used to fill all values in these tables except reach name, length, and change in elevation, which are
obtained from the reach file.  A future enhancement will allow other values to be read from input files.

For land surface response modeling, the COPY block is added with default records for each output
location.  The COPY operations create a series of output data sets to be used for land-surface calibration.
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The EXT SOURCES block for the water budget model is produced using observed data for local inflows.
The available data sets are scanned to find those observed flow data sets at locations named by the same
eight-character identification as a reach. Such data sets are identified as candidates to represent local
inflows, and their drainage areas are stored in a list of candidates. Then a specific data set is chosen to
represent the local inflow to each reach based on the similarity of the local contributing area for that
reach. The multiplication factor for each of these external sources is computed as the product of the value
1.983471 (the conversion factor for cubic feet per second to acre-feet per day) and the ratio of the local
area for this reach to the local area of the data set being used.

For the land-surface-response model, the EXT SOURCES block is produced by adding a record for each
precipitation and evaporation meteorologic segment contributing to each land use.

Regardless of land-surface response is being modeled, a record is added to the EXT SOURCES block for
any reach at the upstream end of the reach connection table that does not appear in the reach table,
provided that the wdm file contains an observed flow data set with that reach name.  Such reaches are
assumed to be external source flow data sets, and the multiplication factor for such records is set to
1.983471, which is the conversion factor for cubic feet per second to acre-feet per day.

The SCHEMATIC block is created using the information in the reach connection file. For either the
water-budget model or the land-surface-response model, a record is added to the SCHEMATIC block for
each reach-to-reach connection.  For land-surface response, the area of each land use contributing to each
reach is computed, and records are added to the SCHEMATIC block for each land use contributing to
each reach.

If land surface response is being modeled, COPY operations will be added to the SCHEMATIC block to
create a series of output data sets for land-surface calibration, with the multiplication factor representing
the ratio of each reach’s contributing area to the total contributing area.

The MASS-LINK block is added using default records for the reach to reach links as well as each link
from a land surface to a reach.  There is no multiplication factor for the reach to reach mass links, but the
multiplication factor of 0.0833333 is used for the land use to reach connections to convert from inches to
feet. For the land-surface-response model, mass links are added for the IMPLND to COPY and PERLND
to COPY operations.

Information for the EXT TARGETS block is determined through a process in which the WDM file is
scanned to find reaches having observed flow data.  Records are added to the EXT TARGETS block to
output simulated flow data at any reaches that have observed flow data.  The multiplication factor for
these records is set to 0.50417 to convert from acre-feet per day to cubic feet per second. If land-surface
response is modeled, then additional records will be added from each COPY operation.

The FTABLES are computed using the rating curves from the rating curve input file.  An FTABLE is
computed for each reach segment.  The rating curve closest in drainage area to the drainage area of the
reach is used. The depth term in the FTABLE comes directly from the rating curve.  The area term in the
FTABLE is determined by multiplying the top width from the rating curve by the length of the reach
segment and multiplying by a conversion factor.  The volume term in the FTABLE is determined by
multiplying the cross-sectional area from the rating curve by the length of the reach segment and
multiplying by a conversion factor.  The discharge term is taken directly from the rating curves.
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Simplify Network

When the input files for the ‘New Scenario’ feature are created from GIS coverages, often the reach
network contains more segments than are appropriate for HSPF modeling.  The ‘Simplify Network’
feature has been developed to combine reach segments to create a more appropriate set of reaches for
modeling.  This feature is accessed by clicking on the ‘Simplify Network’ button in the ‘New Scenario’
form.

Using this feature, the network may be simplified by eliminating reaches with less than a given number
of reaches upstream, or by eliminating reaches with a contributing area smaller than a given percentage
of the entire basin.  This feature will maintain as separate reaches those that are named, have more than a
given number of upstream reaches, represent the confluence of major tributaries, or have a contributing
area greater than a given percentage of the entire basin.
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Three input files are required for the ‘Simplify Network’ feature, containing the reach table, the reach
connection table, and the contributing area table.  The names of these files are specified in the ‘Simplify
Network’ form using the ‘Select’ buttons.  The formats for these files are the same as described above for
the ‘New Scenario’ feature.  In addition to these requirements, the network must have only one outlet, it
must not contain any triple junctions (no more than two reaches can be immediately upstream of any one
reach), and the reach connections must be numbered such that the upstream reach number is less than the
downstream reach number (for instance, if reach 3 is connected to reach 4, reach 3 must be upstream of
reach 4).  The land-use input file is not used for the current version of the ‘Simplify Network’ feature,
but has been included in the input form for a future enhancement.  The user must also specify in the
‘Simplify Network’ form three output file names.  These files will contain the simplified versions of the
reach table, reach connection table, and contributing area table.

The user must also specify near the top of the ‘Simplify Network’ form the three criteria that govern the
simplification of the network.  These three criteria represent the critical number of upstream segments,
the fraction of drainage area at which to combine segments, and the fraction of drainage area at which to
break segments.

As an example of the use of this feature, a user might specify five as the critical number of upstream
segments, 0.02 as the fraction of drainage area at which to combine segments, and 0.2 as the fraction of
drainage area at which to break segments.  When executed, this feature will first identify all reaches that
have less than five reaches upstream.  The contributing area of these reaches will be added to the reach
immediately downstream, unless downstream is a confluence with another tributary.  Then each reach
will be checked to see if it meets the minimum drainage area requirement.  If a reach does not meet the
minimum drainage area requirement, then its contributing area will be added to the reach immediately
downstream.  Finally, each reach will be checked to see if it exceeds the maximum drainage area
requirement. If a reach exceeds this requirement, it will be split into multiple reaches with boundaries
located at boundaries in the original reach network.

The ‘Simplify Network’ operation is run when the user clicks the ‘OK’ button. The ‘Cancel’ button is
used to return to the ‘New Scenario’ form. The ‘Clear Specs’ button initializes the ‘Simplify Network’
form, while the ‘Put Specs’ button allows the user to save the specifications in this form to a file for later
use.  These specifications can be retrieved from a file using the ‘Get Specs’ button.

Once the ‘Simplify Network’ feature has been executed, the ‘New Scenario’ feature can be run using the
output files from the ‘Simplify Network’ feature to create an HSPF input sequence with a more
appropriate number of reaches.
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Constituents

The Constituents frame of the main GenScn form displays available and selected constituent names in a
project. The summary label in the upper left corner of the frame shows a count of the constituents that are
selected and available. The ‘All’ button is used to select all available constituents. The ‘None’ button
deselects all constituents. The list of available constituents is in alphabetical order. Selected constituents
are highlighted.

Time Series

The Time Series frame of the GenScn form displays a list of the time series selected for analysis. For any
time series to be available to GenScn, three attributes must be present - constituent, location, and
scenario. A toolbar and a corresponding menu title are provided to allow the user to manipulate the time-
series list in a variety of ways. In the top right corner of the frame the number of time series in the list is
displayed along with the number of time series available in this project.

If any time series are available in the list, the Dates frame below the Time Series frame will appear. The
Dates frame includes the starting and ending dates of the period common to all time series in the list.
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Add

The Add button in the Time Series frame is used to add time series to the time-series list.  Available time
series that meet the selected scenario, constituent, and location selections will be added.

For example, if the user has selected ‘BASE’ from the scenario list, ‘FLOW’ from the constituent list,
and ‘LYNNWOOD’ from the location list, the time series corresponding to BASE FLOW at
LYNNWOOD will be added. If the user has selected ‘BASE’ and ‘OBSERVED’ from the scenario list,
‘FLOW’ from the constituent list, and ‘LYNNWOOD’ from the location list, two time series will be
added:  BASE FLOW at LYNNWOOD and OBSERVED FLOW at LYNNWOOD.

Remove, Clear

The Remove  button in the Time Series frame is used to remove time series from the time-series list.

The text in the left-most column of the time-series list must be selected for the list item to be removed.
For example, to remove OBSERVED FLOW at LYNNWOOD, click on the text ‘WDM’ in the left-most
column for that list item to select it, and then click on the Remove button. Multiple time series can be
removed at once by highlighting several list items and then clicking on the Remove button.

The Clear  button in the Time Series frame is another way to remove time series from the time-series

list. This button removes all time series from the list if none are selected. If one or more time series are
selected, this button removes the selected time series plus all of the time series below it on the list.

Move

The Move buttons in the Time Series frame are used to move items in the time- series list up or down in
the list.  This capability may be particularly useful for those analysis options which depend upon the
order of the time series in the list, such as the Duration and Compare analyses.

These buttons require one item in the time-series list to be selected.  A list item may be selected by
clicking on the text for that item in the left-most column.  Clicking on the arrow pointing up will move
that item up one place in the list, while clicking on the arrow pointing down will move that item down
one place in the list.
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Columns

The Columns button in the Time Series frame is used to specify characteristics of the columns displayed
in the time-series list.  Clicking on this button produces a form that may be used to manage the columns
of the list.

The Timeseries Columns form contains a list entitled ‘Available Columns’ and a list entitled ‘Show the
Following Columns.’  Items are moved from one list to the other by selecting a list item and then clicking
on the ‘Add’ button or ‘Remove’ button.  When an item in the ‘Show the Following Columns’ list is
selected, the width can be entered in the width field, and the ‘Move Up’ button and ‘Move Down’ button
can be used to move the column relative to the other columns of the time-series list.  The ‘Reset’ button
returns the columns to their default positions.  The ‘OK’ button removes this form while applying these
changes to the time-series list, while the ‘Cancel’ button removes this form without applying these
changes to the time-series list.
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Save Buffer

The Save button in the Time Series frame is used to save the items in the time-series list to a file for later
use.  Clicking on this button invokes the file save common dialog, from which a user may specify the file
name to which this list is to be saved.

Get Buffer

The Get button in the Time Series frame is used to retrieve items in the time-series list from a file.
Clicking on this button invokes the file open common dialog, from which a user may specify the file
name from which this list is to be opened.

This feature is designed so that a user might retrieve a list of items for the time-series list saved
previously to a file. The scenario, location, and constituent specifications are read from the file; and if a
time series is available with those attribute values, it will be added to the time-series list.

Edit Time Series

The Edit button in the Time Series frame is used to edit the attributes of items in the time-series list.  One
or more list items must be selected before clicking on this button.

The ‘Edit’ form contains fields to specify the eight-character scenario, location, and constituent names as
well as the station name.  If one list item has been selected in the time-series list, this form will appear
with the attributes of that one time series.  If multiple items have been selected in the time series list, this
form will appear with only those attributes common to each selected time series available for editing.

The ‘OK’ button removes this form while applying these changes to the time series, while the ‘Cancel’
button removes this form without applying these changes to the time series.
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Dates

The Dates frame of the GenScn form displays the common period of the time series in the Time Series
frame. If no time series are in the list, dates will not be available.

At the bottom of the Dates frame is the available period common to each time series. Above the available
period is the time span to be used in the analysis operations. The user may change the starting and ending
dates for the analysis by clicking in one of these text boxes. After clicking in a text box, the user may
type the number at the keyboard or use the up and down arrows that appear in the frame to move the date
forward or backward. The entire date must be specified (no partial dates allowed).

The TStep and Units fields are used to set the time step and time units for the analysis operation. Below
these fields is a field to set the transformation function for the analysis operation. The ‘Reset’ button
changes the values in these fields back to their defaults.
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Analysis

Analysis options may be invoked by selecting the appropriate button from the analysis toolbar located in
the lower right corner of the main GenScn form. They may also be invoked by selecting one of the menu
items under the Analysis menu title.  The Graph , List , Duration , and Animate  options

require at least one time series to be selected in order to function.  The Compare  option requires two

selected time series.  The Profile Plots  option does not require selected time series, but does require

one scenario and one constituent to be selected from their respective lists.  The File View  option

does not require any time series to be selected.
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Graph

The Graph form is displayed by clicking on the Graph  button on the Analysis toolbar or by selecting

the Analysis:Graph menu item.  The Graph form shows the suite of graphs that may be generated. All of
the graphs are based on time-series data, but only the Standard, Residual, Cumulative Difference, and
Bar Chart plots are time plots.  The Flow/Duration, Difference, and Scatter plots are x-y plots. If there is
only one time series selected, then only the Standard and Flow/Duration plots are available as the
remaining plots require multiple time series. The All button selects all of the available plots for plotting
and the None button deselects them. The Generate button causes all of the selected plots to be created.
The Cancel button closes the Graph form, but will not close any existing plots.
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Graph Menus

All graphs generated by GenScn contain a standard set of menu options for outputting and manipulating
the graph. The File menu is used to output the graph to a printer or windows metafile and to close the
graph form. The Edit menu is used to manipulate the components of the graph (that is, curves, axes,
labels, and so forth). The View menu is used to generate a listing of the graph in a new form.
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Graph/File

The File menu allows the user to print a graph, create a graphic metafile that can be imported into other
applications, or close the graph.

Graph/File/Print
The Print menu item causes the Print dialogue form to be displayed. The desired printer may be selected
and detailed properties specifications (for example, page orientation) may be made using the Properties
button. The number of copies to print may also be specified on this form. The OK button is used to send
the graph to the printer, and the Cancel button is used to abort the printing process.
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Graph/File/Metafile

The Metafile menu item causes the Generate Windows Metafile dialogue form to be displayed.  The top
portion of the form is used to specify the directory path in which to save the file.  The middle portion of
the form displays any existing files of windows metafile type.  The File Name text box is used to enter
the name of the metafile.  If an existing file is selected, a prompt will be displayed to confirm that the
existing file should be overwritten.

Graph/File/Close

The Close menu item removes the graph form from the screen.
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Graph/Edit

The Graph Edit form is displayed when any of the four menu items under the Edit menu title is selected.
The form contains four tabs (Axes, Titles, Curves, and General) with the tab corresponding to the
selected menu item being in the forefront. When a graph is first drawn it is given default values for all
these parameters.

Graph/Edit/Axes

The Axes tab contains radio buttons for selecting the type of X-, Left Y-, and Right Y-axes. An auxiliary
axis is a separate graph above the main graph that shares the same X-axis. A field for specifying the
fraction of the available Y space to use for the auxiliary axis (if it is in use) is also provided. Each axis
frame contains fields for specifying the number of tics and the minimum and maximum value for the
axis. To assist in defining the axis scale, the data range for each axis is also provided. Should values
exceed the axis scale range, the curve will be clipped at that point.
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Graph/Edit/Titles

The Titles tab contains fields for specifying axes labels and the graph title. If an axis is not active, the
field for its label is also not active. For a time-series plot, the X-axis label is generated automatically. Up
to three lines may be entered for the main title. An additional line may be created for the left and right Y-
axes labels by inserting an & symbol that indicates the start of a new line. Two additional lines may be
added to the auxiliary axis label in the same manner.
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Graph/Edit/Curves

The Curves tab contains fields for specifying characteristics of each curve on the plot. The < and >
buttons are used to select the curve to specify parameters for. Properties that appear in this tab reflect the
current values for the selected curve. The Axis field specifies on which axis the curve is to be plotted
(Left Y, Right Y, Auxiliary). Specifications for line type and thickness, marker type, color, value type
(mean over a time span or point at an instant of time), and legend label may also be made. All
specifications except legend label are selected from drop-down lists.
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Graph/Edit/General

The General tab contains radio buttons and fields for specifying the location of the legend. Location
options include no legend, the upper left corner (default), and a user-specified location. Three text fields
are provided to add any additional text to the plot. Location specifications for both the legend and the
additional text are made by entering the fraction of the X- or Y-axis (for example, X Position=0.5, Y
Position=1.0 means half way across the X-axis and at the top of the Y-axis). If labels are available for
data points, the Data Labels control allows a choice between displaying labels horizontally, vertically, or
as pop-up text. Data labels can be turned off by selecting None.

Graph/View

Graph/View/Listing

The Listing menu item creates a text listing of the data that are plotted on the graph.  For a time-series
plot, the first column of the listing displays the date and time and the remaining columns display the
values for each curve.  For x-y plots, first the y and then the x data for each curve are displayed.

Graph/View/Copy

The Copy menu item is intended to create a copy of the current graph for further manipulation.  This
option is not currently implemented.
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Graph Types

Several type of plots can be generated: standard, residual, cumulative difference, bar chart, flow duration,
difference, and scatter.

Graph/Standard

The Standard plot creates a time plot of the selected time series. All time series are plotted on an
arithmetic scale on the left Y-axis by default.  Once the plot is created, the axis types and which curves
are plotted on them may be modified.  A limit of 18 time series may be plotted on a single graph.
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Graph/Residual

The Residual and Cumulative Differences plots create time plots of the difference between the second
and first selected time series. The Residual plot displays the difference between the two time series at
each time interval, whereas the Cumulative Differences plot displays the accumulated difference through
time between the two time series.  If more than two time series are selected, only the first two in the time-
series list will be used for these plots.
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Graph/Cumulative Difference

The Residual and Cumulative Differences plots create time plots of the difference between the second
and first selected time series. The Residual plot displays the difference between the two time series at
each time interval, whereas the Cumulative Differences plot displays the accumulated difference through
time between the two time series.  If more than two time series are selected, only the first two in the time-
series list will be used for these plots.
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Graph/Bar Chart

The Bar Chart plot creates a time plot that shows the value from each time series side by side for each
time interval. This plot is intended for close examination of values over a short period of time. The plot
will lose any useful resolution for longer time spans (for example, greater than 50 time intervals).
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Graph/Flow Duration

The Flow/Duration plot creates a statistical plot of the percentage of time that values for flow or water-
quality constituents are exceeded.  Exceedance intervals are displayed on the X-axis automatically and
the curves are plotted on a logarithmic Y-axis by default.
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Graph/Difference

The Difference plot creates x-y plots using the first two selected time series.  The difference between the
two time series is plotted against the first time series. If more than two time series are selected, only the
first two in the time-series list will be used for this plot.
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Graph/Scatter

The Scatter plot creates x-y plots using the first two selected time series. The second time series is
plotted against the first.  There is an option to display the 45-degree and regression lines on the plot.  If
more than two time series are selected, only the first two in the time-series list will be used for this plot.
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List

The List form is displayed by clicking on the List  button on the Analysis toolbar or by selecting the

Analysis:List menu item.  The initial listing contains values for the selected time series displayed at the
time interval and for the time period specified in the Dates frame.  All lists generated by GenScn contain
a standard set of menu items for outputting and manipulating the list.  The File menu title is used to
output the listed values to a file or printer and to close the list form.  The Edit menu title is used to
manipulate the components of the listing (title, field specifications, summary options, and date format).



   List List/File List

Analysis112

List/File

The File menu allows the user to save, print, or close the list.

List/File/Save

The Save menu item causes the Save List File dialogue form to be displayed. The “Save in” list at the top
of the form is used to specify the directory path in which to save the file. The middle portion of the form
displays any existing files of the file type being saved. The “File name” text box is used to enter the name
of the file. The “Save as type” list is used to select the type of file to which the list is to be saved. The
*.txt extension will save the list to a flat text file. The *.rdb extension will save the list to a RDB file. If
an existing file is selected, a prompt will be displayed to request confirmation before the existing file is
overwritten.
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List/File/Print

The Print menu item causes the Print dialogue form to be displayed. The desired printer may be selected
and detailed properties specifications (for example, page orientation) may be made using the Properties
button. The number of copies to print may also be specified on this form. The OK button is used to send
the list to the printer, and the Cancel button is used to abort the printing process.

List/File/Close

The Close menu item removes the list form from the screen.
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List/Edit

The List Edit form is displayed when any of the four menu items under the Edit menu title is selected.
The form contains four tabs (General, Fields, Summaries, and Dates) with the tab corresponding to the
selected menu item being in the forefront.

List/Edit/General

The General tab contains three text fields for entering a title for the list. Below that are three check boxes
for defining which records to display on the list. The “All Inside” check box indicates that only records
with all data values within the range specified in the Fields tab should be displayed. The “Some In, Some
Out” check box indicates that records with data values inside or outside the specified range should be
displayed. The “All Outside” check box indicates that only records with all data values outside the
specified range should be displayed. The performance of these buttons changes depending on whether the
values are being Listed or Screened, as specified on the Fields tab.
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List/Edit/Fields

The Fields tab contains fields for specifying characteristics of each column in the list. The < and >
buttons are used to select which column’s parameters are being specified. The blanks in this tab are filled
with values for the current field as the field is changed. The Label field is used to specify the column
header. The “Width,” “Significant Digits,” and “Decimal Places” fields are used to specify those
properties for each column. The “Min” and “Max” fields are used to specify the desired data range for
each column. The “List” and “Screen” radio buttons are used to specify whether data values within the
range should be listed or screened out.
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List/Edit/Summaries

The Summaries tab contains check boxes for indicating which time intervals and data transformations are
to be listed. The transformations include average, sum, minimum, maximum, and count of values.
Transformations may only be made to time intervals that are greater than or equal to the time units of the
data. For example, a listing of daily data will have hour, minute, and second transformations disabled.
The Summaries tab is disabled if the listing is not of time-series data. The control in the Year row allows
selection of which month the year ends in. This allows use of calendar years or water years.
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List/Edit/Dates

The Dates tab contains radio buttons for selecting the desired format for the date/time field. The Dates
tab is disabled if the listing is not of time-series data.
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Duration

The Duration analysis tool examines the behavior of a time series, computing a variety of statistics
relating to durations of events above and below certain specified “levels.”  This option may also be used
to access the risk associated with lethal concentrations of contaminants.  This analysis is only performed
for the first time series in the time-series list.  The start and end dates, the time units, and the time step
are set using the dates tool in the main form. This is the DURANL module from HSPF and should not be
confused with the traditional flow duration analysis that is a cumulative frequency curve of a continuous
time series.

The Duration form is displayed by clicking on the Duration  button on the Analysis toolbar or by

selecting the Analysis:Duration menu item.  The Duration form contains a text box near the top of the
form to specify the title of this Duration analysis.  The tabs in the middle of the form are used to specify
parameters for the analysis.  Buttons near the bottom of the form are used to control operation of the
analysis.
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The Durations tab contains a list of available durations and a list of active durations.  Only durations
listed in the active list will be used in the analysis.  These durations represent a number of time steps of
the time unit specified in the dates form on the main form.  Thus the number ‘2’ in the duration list
represents events of 2 days in duration where the time units is set to days.  At least one duration must be
in the active list to run a duration analysis.

To move a duration from one list to another, highlight the desired item in the list and click the arrow
button that points to the destination for this duration.  The entire column of durations can be moved to
the opposite list by clicking on the double arrow button.  Durations not listed in either list can be added
by manually typing them at the bottom of the available list and then clicking on the arrow key that points
toward the active list.  Only positive integer durations can be added to the list.

The Threshold tab contains lists of available and active threshold levels.  The contents of the available
thresholds list is controlled using the parameters in the defaults frame.  To specify whether an arithmetic
or logarithmic series is desired, the number of values in the series, and the lower and upper limits will
result in a series of available thresholds.  Only thresholds listed in the active list will be used in the
analysis.  At least one threshold level must be in the active list to run a duration analysis.
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To move a threshold from one list to another, highlight the desired item in the list and click the arrow
button that points to the destination for this threshold.  The entire column of thresholds can be moved to
the opposite list by clicking on the double arrow button.  Thresholds not listed in either list can be added
by manually typing them at the bottom of the available list and then clicking on the arrow key that points
toward the active list.

The Options tab contains a list of available output options.  Each item in the list of options specifies that
the user wants to obtain that table plus each of the tables above it in the list.  Thus selecting the Fraction
of events with duration ‘n’ option will result in all of the output tables being produced.
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The Lethality tab contains a series of parameters that may be specified if the user wishes to analyze lethal
concentrations.  Lethality analysis will not be performed unless this analysis is set to On.  The critical
level can be toggled between GT for Greater Than values and LT for Less Than values.  The output level
for the lethality analysis can be set to None, Low, Middle, or High.  Up to five lethality curves can be
specified.  For each curve a value should be entered for each duration.  The values for the lethality curves
are entered by double clicking on a cell in the grid, entering the value in the field above the grid, and then
double clicking again in that field.

The Output File button near the bottom of the Duration form is used to set the output file name for the
analysis.  The Close button is used to close the Duration form and return to the main form.  The three
buttons nearest the bottom of the form may be used to Save, Get, or Clear a set of duration analysis
specifications.  These buttons are useful for saving the contents of each of the four tabs for a given
analysis for later use or for clearing the tabs of all specifications to begin a new duration analysis.

Once the input parameters have been specified, the Compute button is used to begin the analysis.  After a
few seconds the Results button will become available, which signals the completion of the computations.
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The Results button produces a form containing the results of the analysis.  Pages of analysis results can
be perused using the page controls.  Results can be printed using the Print button.  The Close button
removes this form.
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Compare
The Compare analysis tool uses the flow-duration analysis and class intervals to compute absolute error,
root mean square error, and bias by class interval for two time series.  This analysis is usually performed
on an observed variable and a simulated variable, although the analysis can be used to compare computed
time series for two scenarios.  This analysis is only performed for the first two time series in the time-
series list.  The start and end dates, the time units, and the time step are set using the dates tool in the
main form.  Results tables can provide insight into the distribution of differences.

The Compare form is displayed by clicking on the Compare  button on the Analysis toolbar or by

selecting the Analysis:Compare menu item.  The Compare form contains a text box near the top of the
form to specify the title of this Compare analysis.  The tabs in the middle of the form are used to specify
parameters for the analysis.  Buttons near the bottom of the form are used to control operation of the
analysis.
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The Class Limits tab contains lists of available and active class limits.  The contents of the available class
limits list is controlled using the parameters in the defaults frame.  Specifying whether an arithmetic or
logarithmic series is desired, the number of values in the series, and the lower and upper limits will result
in a series of available class limits.  Only class limits listed in the active list will be used in the analysis.
At least one class limit must be in the active list to run a compare analysis.

To move a class limit from one list to another, highlight the desired item in the list and click the arrow
button that points to the destination for this class limit.  The entire column of class limits can be moved
to the opposite list by clicking on the double arrow button.  Class limits not listed in either list can be
added by manually typing them at the bottom of the available list and then clicking on the arrow key that
points toward the active list.

The Missing Values tab allows the user to enter the value used to indicate missing values for each of the
two time series.

The Output File button near the bottom of the Compare form is used to set the output file name for the
analysis.  The Close button is used to close the Compare form and return to the main form.  The three
buttons nearest the bottom of the form may be used to Save, Get, or Clear a set of Compare analysis
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specifications.  These buttons are useful for saving the contents of the tabs for a given analysis for later
use or for clearing the tabs of all specifications to begin a new compare analysis.

Once the input parameters have been specified, the Compute button is used to begin the analysis.  After a
few seconds the Results button will become available, which signals the completion of the computations.
The Results button produces a form containing the results of the analysis.  Tabs in this form represent
pages of analysis results.  These results can be printed using the Print button.  The Close button removes
this form.
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Generate

The generate option is a feature intended primarily for advanced users.  This option is used to create a
new WDM data set or fill values in an existing WDM data set.  The values in this data set are determined
one of three ways:  they can be computed from other data sets, transformed from an existing data set, or
manually filled.

The Generate form is displayed by clicking on the Generate  button on the Analysis toolbar or by

selecting the Analysis:Generate menu item.  The Generate form contains three radio buttons in a frame
near the top of the form that are used to select one of the Generate operations.

Compute

The Generate/Compute option is used to transform one or two existing time series into a new WDM
time-series data set based on some mathematical function. The function is chosen from within the
function frame, and any required coefficients must be entered here as well. Selecting a function will
display a formula describing the function. Fields will appear in the time-series frame through which the
input and output time series must be selected. Time series must be specified by number or by selecting a
time series from the time-series list on the main form and then using the From Main button. The scenario,
location, and constituent tags should be set for a new time-series data set.
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The start and end dates, time units, and time step may be specified in the dates frame.  These parameters
will default to the period of record of the input time series.  When ready, the Perform Operation button
may be clicked to perform the operation.
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Transform

The Generate/Transform option is used to shift data in time and/or to aggregate or disaggregate data over
time.  The shifting of data may be needed to correct for errors in recording clocks or to account for
daylight savings time or time zone changes. Aggregation and disaggregation are based on the time-
interval attributes of the input and output time series.  When the time interval of the input time series is
larger than the output time series (disaggregation), the transformations Divide or Same may be selected.
When the time interval of the input time series is smaller than the output time series (aggregation), the
transformations Sum, Average, Max, or Min may be selected.  In both cases the larger time interval must
be an even multiple of the smaller time interval.  When transforming the time step and/or shifting data in
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time, it is important that the start and end dates be compatible with the time step of both the input and
output time series.  For example, with a daily time step, the beginning time is 0:00 and the ending time is
24:00.  All time steps smaller than one day should evenly divide into one day.

The selection of the transform operation will result in the appearance of fields in the time-series frame
through which the input and output time series must be selected.  Time series must be specified by a
number or by selecting a time series from the time-series list on the main form and then using the From
Main button.  The scenario, location, and constituent tags should be set for a new time-series data set.

The function frame is used to specify the starting year, month, and day for the output time series.  The
start and end dates for the input time series, the time units, and the time step may be specified in the dates
frame.  These parameters will default to the period of record of the input time series.  When ready, the
Perform Operation button may be clicked to perform the operation.

Manual

The Generate/Manual option is useful for generating a time series that is constant over many time steps
or for filling a time series that might have some periods of missing data.  The manual option has two fill
choices.  The first choice will fill a time span with a constant value for every time step.  The second
choice will fill a time span using values interpolated from one value to another. This might be the case
should a user wish to interpolate from the last value of a time series up to a given value over a certain
time span.

The selection of the manual operation will result in fields appearing in the time-series frame through
which the output time series must be selected. This time series may or may not already exist.  The time
series must be specified by a number or by selecting a time series from the time-series list on the main
form and then using the From Main button.  The scenario, location, and constituent tags should be set for
a new time series.
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The function frame is used to specify the manually filled value and whether this value should be applied
to all time steps or whether the data for these time steps should be interpolated to that value.  The start
and end dates for the time series, the time units, and the time step may be specified in the dates frame.
These parameters will default to the next time step after the period of record of the time series.  When
ready, the Perform Operation button may be clicked to perform the operation.
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File View

The File View analysis tool is provided as a means of viewing any ASCII file from within GenScn.
Clicking on the File View  button in the Analysis toolbar (or selecting the Analysis:File View menu

item) will invoke the File Open common dialog, from which the user may specify the file to be viewed.
After specifying the file name, the File View form will appear with the file text in a text box.

The File View form displays files one page at a time.  At the bottom of the form is a set of buttons and a
text box which are used to move through the file.  The buttons are used to move forward or backward
through the file.  The text box is used to enter a specific page number to which to move.  The field to the
right of the buttons displays the total number of pages in the file.  An additional list at the bottom of the
form allows the user to select the format in which to view the file.  The Plain Text option will fill each
page with the maximum amount of text without using vertical scroll bars.  The FORTRAN Output option
will perform in this manner also with the exception that a new page will be formed whenever a
FORTRAN carriage control character for new page is encountered.  Although options for viewing in
Binary and ESRI Shape File format exist, they are not used in GenScn.  This file can be printed using the
‘Print’ button.  The ‘Close’ button removes this form.
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Animate
The Animate analysis tool provides a visual technique for observing data through time. A map, similar to
the map on the main form, is redrawn at each time step, which illustrates the range the current parameter
is in at various locations along a stream network. This tool is only available where the shape file for the
map layer to be animated contains separate segments that can be identified and drawn individually.

Animation is only performed on the time series in the time-series list for one scenario and constituent.
Thus, one and only one scenario and constituent must be selected on the main form, and any time series
at desired locations must appear in the time-series list.

The Animate form is displayed by clicking on the Animate  button on the Analysis toolbar or by

selecting the Analysis:Animate menu item. A map appears in the form, and below the map is a list of the
time series that will be included in the animation with specifications of how these animation segments
should be drawn. The user has the option of specifying two threshold values and a color and size of line
segments for values falling below, between, and above the two threshold values.
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The current date in the animation appears at the top right corner of the form. Below the data is a series of
control buttons, which control movement of the animation through time. The buttons perform the
following movements, from left to right: move backward, move backward one time step, pause, move
forward one time step, and move forward. The button below the pause button stops the animation.

The ‘Save Map’ button saves the current animation frame to a windows metafile. If the map toolbar is
enabled, this button also allows saving as a map file, bitmap, or clipboard image. The ‘Print Map’ button
prints the current animation frame. The ‘Profile Plot’ button produces a plot of the animated constituent
at the point in time of the animation at each location along the main stream channel. The main stream
channel must be specified in the shape file for the streams. See Profile Plots for more details.

The ‘Save Specs’ button, ‘Get Specs’ button, and ‘Clear Specs’ button may be used to Save, Get, or
Clear a set of Animate specifications. These buttons are useful for saving the contents of the segment list
for later use, or for clearing these specifications to begin a new Animate analysis. The ‘Cancel’ button is
used to close the Animate form and return to the main GenScn form.

When one or more of the segments in the segment list is selected, the ‘Modify’ button is available.  See
Modify for more details.

Modify
The Animate Modify form is invoked when the user clicks on the ‘Modify’ button in the Animate form
with one or more segments selected.  This form allows the user to change the parameters for each
Animation segment selected.

The lower and upper boundaries may be set, as well as the color and line thickness for low, medium, and
high values.  Low values are those falling below the lower boundary, and high values are those falling
above the upper boundary.  Medium values are those that fall between the lower and upper boundaries.

Once these parameters are set as desired, the ‘OK’ button is used to apply these changes to the Animate
form.  The ‘Cancel’ button is used to return to the Animate form without applying these changes.
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Profile Plots

The Profile Plot form is displayed by clicking on the Profile Plot  button on the Analysis toolbar or

by selecting the Analysis:Profile Plots menu item.  Profile plots require one constituent to be selected for
plotting and at least one scenario selected as well. The locations used in the profile plot will be
determined from the selected scenario(s).

The first two lines of the Profile Plot form display the scenario(s) and the constituent to be plotted. The
Branch/Node specification frame is used to select the desired river segments for which to plot profiles.
The available branches for the selected scenario(s) are displayed in the Available list. Starting,
intermediate, and ending branches are specified by selecting an available branch and then clicking on the
‘Start’ button, ‘Intermed.’ button, or ‘End’ button. For the starting and ending branches, the starting and
ending nodes may be selected from the Node lists. By default the first node in the starting branch and the
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last node in the ending branch are selected. All nodes in the intermediate branches will, by definition, be
displayed. Thus, there is no node specification for intermediate branches. The ‘Remove’ button will clear
any highlighted branches in the starting, intermediate, or ending branch lists and return the branches to
the available list. A branch may be highlighted (or unhighlighted) by clicking on it.

A branch is a one-dimensional river segment which begins either at the top of the watershed or at the
junction of two branches and ends either at the bottom of the watershed or at a junction with another
branch. Nodes are intermediate points along branches.

The Time Specification frame allows the user to choose one of three methods to plot the profiles.
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The Intervals option allows the user to select specific instances of time for which to plot a profile. Time
instances are selected from the Available list of time intervals by clicking on them and then clicking on
the ‘-->’ button to move them into the Selected list. To remove a time instance from the Selected list,
highlight it by clicking on it and then click on the ‘<--‘ button to return it to the Available list. Click the
‘Plot’ button to create the plot.
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The Peaks option will plot a profile of the highest values that occurred for each scenario being plotted.
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The Animate option allows the user to view the profile(s) through time. When the Animate option is
selected, the user must select a starting time interval by clicking on it from the Available list. This will
fill in the Date text box with the selected time interval. Once the ‘Plot’ button is clicked and the initial
profile plot is displayed, the user controls the movement of the animation through time. This is done
using the control buttons above the Date text box. The buttons perform the following movements, from
left to right: move backward, move backward one time step, stop, pause, move forward one time step,
and move forward.
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Note that for a profile plot generated with the animate option, the scale for the y-axis is set based on the
range of values for the entire time span. Thus, one significant peak value may extend the y-axis scale to a
value much higher than desired for the majority of the other values. However, the axis scaling may be
modified at any time during the animation by selecting the Axis menu item from the Graph menu on the
plot form or by dragging the top y-axis.

The Stage Specification frame contains options for the display of stage values on the profile plot. By
default, only the stage values will be plotted. If there are invert values available, the user has the option
to plot the sum of the invert and stage values. Additionally with this option, the user may also specify to
plot the invert on the profile plot. Obviously these options only apply when items such as stage or water-
surface elevation are being plotted.

The ‘Plot’ button is used to generate the desired profile plot. It is disabled until the needed specifications
are made (that is, start/end branch defined and time specifications made). The ‘Cancel’ button closes the
Profile Plot form but will not remove any existing profile plots.
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Help

The GenScn Help System is invoked by using the Help menu from the main window. See Help in the
User Interface section for more details.
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Setting Up a New Scenario Generator

Setting up a new scenario generator involves preparing GIS data and time-series data, and creating and
calibrating the base scenario.  An illustration of the overall process of setting up a new project is
discussed in Lesson 7 of the tutorial.

The following are the major steps required in setting up GenScn:

Step 1:  Obtain GIS Data

The GIS Data section provides details on the required GIS data.  Obtaining these data is independent of
the GenScn system.  Once the GIS data are obtained the Map Specifications File must be produced using
a text editor.

Step 2:  Create a New Project File

The New Project File can be created from within GenScn using the New Project feature. During this step
the user will create the ‘.sta’ file and a new WDM file.

Step 3:  Import Time-series Data

This step can be performed within GenScn as well, using the Activate feature. The user activates the
OBSERVED scenario to import time-series data in RDB or WATSTORE format. See also the section
entitled Time-Series Data.

Step 4:  Create the BASE Scenario

GenScn assists the user in creating a base scenario with the New Scenario feature. The user must be able
to specify basic characteristics of the watershed such as the number of reaches to model and the area
contributing to each reach.

Step 5:  Setting Model Parameters for the BASE Scenario

GenScn prepares the files to be used in calibration through the ‘New Scenario’ feature, but the actual
calibration process is performed using the Expert System (HSPEXP). See also the section entitled Model
Parameters.

Step 6:  Create Other Scenarios as Desired

At this point the full capabilities of GenScn may be used.  Additional scenarios may be created from the
BASE scenario using the Activate option.  Simulations may be run for a range of scenarios, and then
analyzed using GenScn’s suite of analysis tools.
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Geographical Information System Data

The layers to be displayed on the map must take the form of Environmental Systems Research Institute
(ESRI) shape files. The details of how these shape files are specified can be found in the appendix in the
section entitled Map Specifications.

GIS data must be specified if mapping is to be available within GenScn for the watershed being modeled.
GIS data are also needed to provide the connectivity necessary for the Animate and Profile Plots analysis
options. The GenScn release notes describe how to set up a watershed if GIS data is not available.

For the Animate analysis, the map layer to be animated must contain a field named ‘IDLOCN,’ which
corresponds to the eight-character location names for the time series.  The map layer to be animated must
be specified in the Project Status file.

For the Profile Plot analysis, the stream reach shape file must contain four particular fields.  A field
named ‘IDLOCN’ must correspond to the eight-character location names for the time series.  A field
named ‘BRANCH’ must specify the branch to which this stream reach belongs, such as the South Fork,
North Fork, or Main Stem.  A field named ‘DOWNID’ must specify the ‘IDLOCN’ immediately
downstream of this segment.  A field named ‘LENGTH’ must specify the distance from the outlet of the
reach network.  The map layer containing all of these fields must be specified as the map layer to be
animated in the Project Status file.

Time-Series Data

Time-series data can be imported for use in GenScn by clicking on ‘Observed’ in the scenario list and
then clicking the ‘Activate’ button. The user will be presented with the option of entering observed data
in RDB or Watstore daily values formats.  After choosing one of these options, the user proceeds to a
form to enter the name of the file in which the data resides.  Once the file name is specified, the user may
input the characteristics of the data set including the eight-character scenario, constituent, and location
attributes.

See Activate for more details.

Model Parameters

Once the GIS data and the time-series data have been prepared and brought into a new project and a base
scenario has been created, the base scenario must be calibrated. The program HSPEXP, the Expert
System for the Calibration of HSPF, is designed to assist users in calibrating HSPF hydrology (Lumb and
others, 1994)
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Appendix

Project Status - *.sta

The Project Status file may be created from within GenScn using the File:New menu item.  This file may
be edited using the File:Edit menu item.

The status file contains names and paths specifying files referenced for that project.  These files consist
of the WDM message file, the time-series WDM file, the map file, the time-series RDB files, and the
FEQ output files.  Each line of the project status file contains a three-letter file-type identifier followed
by one space and then the fully qualified file name.  For time-series WDM files the three-letter identifier
is followed by one space and then a four-character WDM file identifier (as used in HSPF) and one space
before the file name.

The following is a list of the valid file-type identifiers:

• WDM - time-series wdm file,
• MES - wdm message file for HSPF,
• MAP - map specifications file,
• RDB - relational data base files containing time-series data,
• FEO - FEQ output files,
• SCN - scenario identifier,
• CON - constituent identifier, and
• LOC - location identifier.

A special type of identifier, SCN, is used to indicate the path to files associated with a scenario.  Use of
this identifier is optional if the files associated with a scenario reside in the same location as the project
file. However, if the scenario files, including the HSPF UCI file, reside in a folder other than the folder
containing the project status file, the SCN identifier must be used, followed by one space, the scenario
name, one space, and the path to that folder.

Glossary information may be appended to SCN, CON, and LOC entries. This information will appear as
a popup message when the user moves across the related part of the main window.

An example Project Status file is included below.

MES ..\hspfmsg.wdm
MAP shena.map
WDM WDM1 shena.wdm
SCN BASE,,,’Base Run’
SCN OBSERVED,,,’Observed Data’
SCN PROFILE,,,’Profile Plot Test Run’
CON AGWO,’active grounwater outflow’
CON ATMP,’air temperature’
CON DEWP,’dewpoint’
CON EVAP,’potential evpotranspiration’
CON FLOW,’streamflo’
CON IFWO,’interflow’
CON PREC,’precipitation’
LOC BURKETOW,’Burketown’
LOC CHRISTIA,’Christian’
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Map Specifications - *.map

This file can be created using a text editor. GenScn will also save this file when the Save button on

the map is clicked. The map file contains information about the layers to be included on the map as well
as other default map parameters.

The map file contains lines starting with a three-letter prefix. All information following the prefix must
remain on the same line. None of the parts of this file are case-sensitive.

• EXT specifies the default extent of the map with four real numbers (left, top, right, and bottom
edges). This allows saving a map zoomed to a particular area of interest, but does not restrict
zooming in or out after the map is loaded.

• LYR describes a layer. Layers appear in the order they will be drawn on the map. The first LYR in
the file will be drawn first and the last one will be drawn last, on top of all the other layers. This is
opposite the order the layers appear in the Edit Map Display Attributes form.

The first attribute of a layer must be the layer’s ESRI SHP file name enclosed in single quotes and
followed by a comma. The second field must be a color for the layer. This will be used as the fill color
for areas, the marker color for points, or the line color for linear coverages such as rivers. Colors can be
specified either as a single red-green-blue integer or as a name from the following list: Black, Red,
Green, Blue, Magenta, Cyan, White, LightGray, DarkGray, Gray, PaleYellow, Yellow, LimeGreen, Teal,
DarkGreen, Maroon, Purple, Orange, Khaki, Olive, Brown, Navy.

The rest of the layer description line is optional and may occur in any order. A comma must separate
each attribute. If a layer is not being displayed, the word HIDE should appear. ANIMATE should be
specified for each layer that can be animated. A drawing style can be chosen with the keyword STYLE
followed by a space and a style name. For points, the style can be Circle, Square, Triangle, or Cross. For
lines, the style can be Solid, Dash, Dot, DashDot, or DashDotDot. Recommended styles for areas are
Solid and Transparent. Transparent indicates that only the boundaries of an area should be drawn. To
specify an outline color for an area or point layer, use the keyword OUTLINE followed by a space and an
outline color integer or name. To specify a size for markers in a point layer, use the keyword SIZE
followed by a space and an integer. Marker size is measured in printer’s points.

If a layer is going to be used for selection, use the word KEYS followed by the name of the field in the
DBF that will be used for selection, in single quotes. If a layer might be labeled or used in identify mode,
use the keyword LABELS followed by the name of the field in the DBF that will be used for labels, in
single quotes.

• LAB lines describe details of how labels should be formatted on the most recent layer of the map.
This line optional. If omitted, labels can be activated and formatted with the Labels form. The first
string after the keyword LAB must be the name of the field in the DBF that will be used for labels, in
single quotes. Other allowed parameters are Bold, Italic, Underline, Font followed by the name of a
font in single quotes, Size followed by a decimal number of points, Color followed by a name or
numeric color, and HorzAlign or VertAlign followed by Top, Bottom, Left, Right, Center, or
Baseline to align the label with the features in various ways.

• DBF lines describe fields from the DBF portion of a shape file layer that should be displayed in a
table under the map for the most recent layer. Each DBF line contains the name of a field in single
quotes. This may be followed by a comma and a caption in single quotes if the column should have a
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caption different from the field name. If a table is desired and the layer has specified KEYS and/or
LABELS, these should also be included as columns in the table.

• REN lines describe rules for rendering the most recent layer. These rules take precedent over the
color and style specified in the LYR line. After REN is the type of renderer: Value or Class. A value
renderer applies to discrete values while a class renderer applies to ranges of values. Next is the
name of the database field used, then the number of rendering styles. Following the REN line there is
one line for each rendering style. These lines start with three spaces and contain the database value to
be rendered with this style followed by the color, symbol style, and outline color as they would
appear in a LYR line.

An example map file is included below.

EXT 1084581.00390625 2063773 1777464.24609375 1576470.5
LYR ‘gis\st.shp’,RED,Style Transparent,Outline RED,Name ‘State’,Keys ‘ST’
LAB ‘ST’,Font ‘Arial’,Size 11.25,Color BLACK,Bold,HorzAlign Center,VertAlign
Baseline
REN Value ST 2
WV,15981829,Style Solid,Outline BLACK
VA,16744448,Style Solid,Outline BLACK
LYR ‘gis\cat.shp’,12508638,Style Solid,Outline BLACK
LYR ‘gis\cnty.shp’,GREEN,Style Transparent,Outline GREEN,Hide,Name ‘County’
LYR ‘gis\rf1.shp’,BLUE,Style SolidLine,Animate,Name ‘Rivers’,Keys
‘IDLOCN’,Labels ‘PNAME’
DBF ‘RF1_ID’
DBF ‘PNAME’
DBF ‘IDLOCN’
DBF ‘BRANCH’
LYR ‘gis\points.shp’,TEAL,Style Square,Size 5,Name ‘Locations’,Keys
‘IDLOCN’,Labels ‘NAME’
DBF ‘IDLOCN’,’Location ID’
DBF ‘REACH’,’Reach’
DBF ‘NAME’,’Name’

Error and Warning Message - ERROR.FIL

GenScn uses the ERROR file to store error and warning messages.  This file is written by GenScn during
normal operation.  The information contained in this file may be useful in understanding a problem
related to the operation of GenScn. It may be viewed using any editor.
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Time-Series Buffer - *.tsb

The Time-Series Buffer file contains a list of scenario, location, and constituent attributes for each time
series in the time-series list.  The contents of this file are written when using the Save Buffer option. The
file is read when using the Get Buffer option.

The Time-Series Buffer file contains one record for each time series in the list.  The record consists of
the scenario, location, and constituent names in quotation marks and separated with a comma.

An example Time-Series Buffer file is included below.

“OBSERVED”,”LYNNWOOD”,”FLOW”
“BASE”,”LYNNWOOD”,”FLOW”

Compare Specifications - *.gco

The Compare Specifications file contains a set of specifications from a GenScn Compare analysis.  This
file may be created and retrieved from the Compare form.

Each item in the compare specifications is stored on a separate record. An annotated example of a
Compare Specifications file is included below. Actual files do not contain descriptions of each item and
do not include blank lines when there are zero items in a list.

0 Integer number of class limits in available list.
N-records of integer values representing available class limits.
6 Integer number of class limits in active list.
0 N-records of integer values representing active class limits.
1
10
100
1000
10000
1 Value representing the lower default class limit.
10000 Value representing the upper default class limit.
False Using arithmetic default? (True or False).
True Using logarithmic default? (True or False).
5 Index of number of default class limits.
-99999 Missing value for first time series.
-99999 Missing value for second time series.
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Duration Specifications - *.gdu

The Duration Specifications file contains a set of specifications from a GenScn Duration analysis.  This
file may be created and retrieved from the Duration form.

Each item in the duration specifications is stored on a separate record. An annotated example of a
Duration Specifications file is included below. Actual files do not contain descriptions of each item and
do not include blank lines when there are zero items in a list.

0 Integer number of durations in available list.
N-records of integer values representing available durations.

9 Integer number of durations in active list.
1 N-records of integer values representing active durations.
2
4
6
8
10
12
18
24
0 Integer number of thresholds in available threshold list.

N-records of values representing available thresholds.
5 Integer number of thresholds in active threshold list.
1 N-records of values representing active thresholds.
2500
5000
7500
10000
1 Value representing the lower default threshold.
10000 Value representing the upper default threshold.
True Using arithmetic default? (True or False).
False Using logarithmic default? (True or False).
4 Index of number of default thresholds.
True Eight records representing output level values (True or False).
False
False
False
False
False
False
False
True Is lethality off? (True or False).
False Is lethality on? (True or False).
True Four records representing lethality output levels (True or False).
False
False
False
0 Index of number of lethality curves.
True Is critical level ‘Greater Than’?
False Is critical level ‘Less Than’?
1 Integer number of rows in lethality grid.
2 Integer number of columns in lethality grid.
Duration One record containing value for each column
Curve 1 of each row in lethality grid.
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Animate Specifications - *.gan

The Animate Specifications file contains a set of specifications from a GenScn Animate analysis.  This
file may be created and retrieved from the Animate form.

Each item in the animate specifications is stored on a separate record. An annotated example of an
Animate Specifications file is included below. Actual files do not contain descriptions of each item.

3 Integer number of records in animate list.
2670 Lower boundary for first record
8020 Upper boundary for first record
Red Low color for first record
Yellow Mid color for first record
Green High color for first record
Thin Low thickness for first record
Thin Mid thickness for first record
Thin High thickness for first record
545 Lower boundary for second record
1640 Upper boundary for second record
Red Low color for second record
Yellow Mid color for second record
Green High color for second record
Thin Low thickness for second record
Thin Mid thickness for second record
Thin High thickness for second record
3020 Lower boundary for third record
9070 Upper boundary for third record
Red Low color for third record
Yellow Mid color for third record
Green High color for third record
Thin Low thickness for third record
Thin Mid thickness for third record
Thin High thickness for third record

Full Equations Model Output - *.feo

Output files from the Full Equations Model (FEQ) can be used as input files to GenScn without
modification.  Three files are required to specify the FEQ output data available to GenScn. They are the
*.ftf, *.feo, and *.tsd files. The *.feo file is an ASCII file which describes the FEQ model run and its
output. GenScn references *.feo files. The *.feo files reference *.ftf and *.tsd files. All of these files are
documented in the FEQ manual.



Relational Data Base - *.rdb150

Relational Data Base - *.rdb

Relational Data Base (RDB) files can be used in GenScn as time-series files. These files can also be
converted within GenScn to WDM data sets.

The required format for RDB files involves the tab character used as a delimiter between columns of
data.  Comment lines must begin with the pound character.  The first non-comment line should include a
row of tab-delimited column headers.  The first header should be ‘Date,’ followed by as many other
headers as columns of data.  The next non-comment line should include a row of tab-delimited data type
codes indicating for each column the width and type of value (10d indicates a 10-character wide date, and
8n indicates an 8-character wide numeric).  All of the following non-comment records must include a
date in YYYY.MM.DD format followed by the time-series data values for that date delimited by the tab
character.

A segment of an RDB file has been included below as an example:

Date Discharge
10s 8n
1936.04.01 120.00
1936.04.02 140.00
1936.04.03 130.00
1936.04.04 130.00
1936.04.05 120.00
1936.04.06 120.00
1936.04.07 120.00
1936.04.08 120.00
1936.04.09 130.00
1936.04.10 150.00
1936.04.11 150.00
1936.04.12 150.00
1936.04.13 130.00
1936.04.14 120.00
1936.04.15 120.00
1936.04.16 99.00
1936.04.17 87.00
1936.04.18 75.00
1936.04.19 75.00
1936.04.20 64.00

Hydrologic Simulation Program-Fortran Message Watershed Data
Management

The Message WDM file is a binary file containing information necessary for the HSPF model and the
WDM system.  This file contains information regarding each HSPF model parameter as well as the
assortment of messages that HSPF may produce under various circumstances.  For more information
about this file see the documentation for the HSPF model and the Annie system.
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Hydrologic Simulation Program-Fortran Status

HSPF has been enhanced to write out a file of state variables a the end of a run and read the file at the
beginning of a new run. This enhancement allows a base uci file to be used in a real time environment.
Short runs can be made with current conditions as they become available. A key feature of this
enhancement is that the base uci file need not be edited.

IMPLEMENTATION:

Two new files have been designed and implemented - a status save file (type STASAV) and a update
start/end date file (type UPDATE). Both are formatted sequential files.

The UPDATE file contains one record which specifies an update to the start and end date for the run
(format (2(I5,4I3,3X)) with the same formatting conventions as the start and end dates in the GLOBAL
block. If this file is referenced in the FILES block, it will be used. I envision that this file may be written
by a driver program which is processing current data.

The STASAV file contains a record for each state variable referenced in the uci file. The format for each
record is (2X,A6,I3,1X,A6,3I3,1X,F12.0,I4). The fields are as follows:
A6  - operation name
I3  - operation number
A6  - variable name
3I3 - variable subscripts (not yet implemented)
F12 - value of state variable, use -1 for no update needed
I4  - repeat value in osv - used to fill in starting storages for mass bal

If initial conditions from the uci are to be used, the value of the state variable in the STASAV file should
be -1.

Time-Series Watershed Data Management - *.wdm

The Time-Series WDM file is a binary file designed especially for storing time-series data.  WDM files
can be created using the utility program ANNIE.

In order for data sets in a time-series WDM file to be usable by GenScn, the data sets must have non-
blank values for three particular WDM attributes: IDSCEN, IDCONS, and IDLOCN.  These attributes
can be added or modified using the program ANNIE.  See the User’s Manual for ANNIE, Version 2 for
more details.  The attributes may also be edited within GenScn using the Edit Time Series feature.  New
data sets are created whenever a new scenario is saved, according to the numbering scheme specified by
the user.
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